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The compilation of texts and pictures was made with the utmost care. Nevertheless, errors can not be completely 
excluded. Editor and authors can not take on responsibility for incorrect information and the consequences 
thereof neither legal responsibility nor liability of any kind. The publisher is grateful for information on any error. 

***

WARRANTY AND LIABILITY ADVICE

This software is to facilitate your terrestrial navigation only. It is not a certified aviation equipment and does not 
replace any aircraft instrument. You are explicitly cautioned to verify that the hardware employed is functioning  
correctly and does not interfere with the aircraft or other vessel in a hazardous manner. Data errors and computer 
errors are possible. This also pertains to the IFR data and procedures implied in the respective modules. Human 
error can make the moving map, nav data or any supplemental  information incorrect.  The pilot in command 
remains the final authority on the accuracy and sufficiency of the hardware and software.

Warranty and Liability Disclaimer:

The manufacturer, distributor or sales agent resume no liability as to the correct function of the software, the 
availability of a reference signal (GPS) or the validity of the charts, nav data or any supplemental information like 
airport information and others. Never will the manufacturer, producer, sales representative and neither of their 
staff be liable to you for any consequential incidental or indirect damages (including damages for loss of business 
profits, business interruption, loss of business information and the like) arising from the use of or inability to use 
the software even if any of the staff mentioned above has been advised.

There is no warranty, express or implied, including without limitation the implied warranties of merchantability and 
fitness for a particular purpose, regarding the software. The entire risk as to the results and performance of the  
hardware and software is assumed by you.
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1. MT Basic
1.1. Power on MT VisionAir X and confirm the disclaimer 
with AGREE

The MT VisionAir X turns on automatically as soon as it is connected to 
permanent power (power supply or on board power). If the system runs on 
batteries it has to be switched on manually.
Use the button in right corner for switching ON / OFF the MT VisionAir X,
press it for about 2-3 seconds.

Confirm the disclaimer by pressing AGREE.
If NO is pressed, a restart of the system is necessary. 

Remark: The last configuration remains saved.  

1.2. Positioning via GPS / related info in the Info Box
The MT VisionAir X starts in Flight Mode → the GPS position is displayed on the chart

If the chart is not positioned correctly check the Info Box.
To display Info Box choose → CHART (or → navWPT) 

NO DATA: GPS not connected

SATACQ: GPS connected OK, reception too bad for positioning

SATFIX 8: Positioning, the subsequent number equals number of
satellites in sight.
Positioning possible from SATFIX 4 on

DISTORTED: Reception distorted or wrong protocol 
(check   → AUX → SETUP → GPS)

1.3. Dimming the screen 

Use the  * button in the left corner to dim the screen. 
Repeated pressing improve the dimming, after 5 steps it 
returns stepwise to full brightness. 
For control check the blue boxes in the screen. 

MTEX/IA-05-05 11



ATTENTION: Dimming will be saved!

• If the system is powered off in the night mode the screen seem to be almost black  

when it is powered again in bright sunlight.  

• Check the brightness by pressing the *  button!

1.4. Restart of MT VisionAir X (wait stead)

In case the MT VisionAir X has to be restarted, it is important to wait at least 5 seconds 
before rebooting.

If the restart is too fast, the boot process may not start correctly. The screen remains black 
and the following error message is displayed: 

1. MT VisionAir X Systeme mit SP Board
"Reboot and Select proper Boot device 
or Insert Boot Media in selected Boot device and press a key"

2. MT VisionAir X Systeme mit TT Board
"EFI Shell version 2.00 [4.641] 
Current running mode 1.1.2
map: Cannot find required map name."

Remark:
Check the type so -> AUX -> SETUP -> VERSION -> VERSION: Here you can find the 
information about SW and OS version, HW ID and the board type. 

This is a normal process!
Wait for some seconds and start the system again. 
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1.5. Keyboard

1.5.1. Hot Keys - Flight Mode

MTEX/IA-05-05 13



1.5.2. Hot Keys – Map Mode

Comments: Camera needs to be set in the rights
Birds View = Birds prospective in MT Terrain EFIS

Hotkeys always work only from the main menu 

1.5.3. Positioning of chart using the arrow keys

K = switch to MAP Mode             K =  Switch to FLT Mode                K = STOP = Stop chart movement

The buttons Z / X and Y / 1 and 2 are allocated analog mirror-inverted.
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1.6. Simulator mode

1.6.1. Switch on the simulator

Every MT VisionAir X provides a simulator mode
→ AUX → TRACK → SIM ON

The simulator mode is labeled by SIMULATOR in a white, outlined red box.

1.6.2. Switch off the simulator mode

→ AUX → TRACK → SIM OFF

Attention: Make sure the simulator mode is stopped before flying.
The box SIMULATOR must be gone!

1.6.3. Adjust the parameter in simulated flight

The simulated flight can be adjusted from the main menu:

To adjust the flight altitude – use hot keys 
H higher (gradually + 100 ft)
G lower (gradually - 100 ft)

To adjust the speed use 
3 faster (gradually + 10 kts)
4 slower (gradually -10 kts)

To adjust the heading use 
L turn heading to left also X
M turn heading to the right also Y

Use the simulator mode for flight preparation.
We recommend to use the simulation mode to understand the explanations of 
functions and adjustments in this manual.   
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1.7. Symbols on the screen

1.7.1. Overview: Synchronized 2D / 3D

                                              Roll / Bank attitude      Pitch incrementals

Pitch attitude

Horizon line

GPI = Glide Path 
indicator (birdy)

Calibrated 
airspeed

Tape drive for 
speed

Ground speed

Magnetic track

UTC

                                                                            Vertical speed
Tape drive for altitude      Terrain clearance                            Destination            Next                 Direct
    (incl. trend)                   (analog to radar altitude)
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1.7.2. On the chart

Left part of the display (from top to bottom) 

1. Ground speed (kts or km/h)
2. Information to interfaces to warning systems or displayed warnings:

1. TCAS Traffic Collision Avoidance System
2. TAWS Terrain Alert and Warning System 
3. Stormscope

Right part of the display
 

1. UTC (via GPS)
2. Coordinates
3. Altitude (in ft) via GPS
3. Info to autopilot mode (autopilot direct, route or heading)
4. Direct: magnetic course, distance in nm and EET 
5. Route information: Next waypoint, destination waypoint

Positioning symbols

1. Aircraft or helicopter symbol, position marked by the red dot
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2. If GS is less than 2 kts: „Hover“ symbol 
3. Loosing the GPS position „GPS SAT ACQ“
4. Off-center-mode shows more chart for the heading (switch to center-mode use  → 

VIEW).
5. Trend vector: Length of the arrow varies according to scale and zoom factor, the 

distance between the red dot and the arrowhead is give, here 15 nm

The distance is either given  
in cyan diamond (see picture) → course rose off
on the range rings → course rose on

6. DIRECT = light blue line
7. Routes are drawn with white vectors, the active leg turns magenta 
8. Showing of the course rose → VIEW →  CRS+, hide course rose → VIEW → CRS -)

1.7.3. Full Screen Terrain (Relief Dynamics)
(→ EFIS → TERRN)

The MT Terrain EFIS is displayed correctly from ground speed 39 kts on. If the speed 
is lower, the display is crossed out red.  

18 MTEX/IA-05-05



Left Part of the Display

1. CAS = Calibrated Airspeed (in kts or km/h), calculated from ground speed, climbing 
descending rate, air density and wind – with trend (yellow bars showing upwards / 
downwards)

2. Ground speed (kts or in km/h)
3. Information to connected warning systems or warnings:

- TCAS Traffic Collision Avoidance System
- TAWS Terrain Alert and Warning System 
- Stormscope

Right Part of the Display
 

1. Altitude (in ft) from GPS with trend for climbing / descending (true altitude above 
MSL)

2. RA = Radar Altitude (in ft): distance between earth's surface and aircraft
Up  to an elevation of 490 ft above earth's surface the RA is visualized by linear 
function, from 490 ft  on the visualization is logarithmic.

3. VS Vertical Speed: Climb (+) or descent (-) rate in FPM (feet per minute)
4. Info to autopilot (autopilot direct, route or heading)
5. Direct: Magnetic course, distance in nm and calculated arrival time 

Symbols for Attitude

1. Bank: Bank angle 10°, 20° (one dash each), 30° (triangle), 40°/45°/50° (dashes) and 
60° (triangle)  

2. BIRDY: Pitch trend = position in 2 minutes 
3. Pitch: - white symbol with flaps (calibrated in EFIS settings) 

- red symbol without flaps  
4. Horizontal line = altitude and elevation due to relation to the terrain 
5. Magnetic Track in °
6. UTC (reception from GPS)

Highway in the Sky

1. DIRECT: Light blue frames leading to the chosen DCT – in case of an airport pointing 
to the ARP = Airport Reference Point.

2. ROUTE: white frames, active leg: magenta frames 

3. NEAREST Airport: Light green frames mark a virtual ILS:
length 7 nm from thresholds
angle: 3,5°

 

MTEX/IA-05-05 19



1.7.4. EFIS Horizon (→ EFIS → HORIZ)

The MT EFIS is displayed correctly from ground speed 39 kts on. If the speed is lower, 
the display is crossed out red.  

Left Part of the Display

1. AOA = Angle of Attack (following the calibration data) 
2. Flight Path Angle = slope of the aircraft in °
3. CAS = Calibrated Airspeed (in kts or km/h), calculated from ground speed, 

climbing descending rate, air density and wind – with trend (yellow bars showing 
upwards / downwards)

4. Ground speed (kts or km/h)
5. 2 MIN TURN = Standard Rate Turns 3° per second = 360° in 2 minutes

Right Part of the Display
 

1. Altitude (in ft) from GPS with trend for climbing / descending (true altitude above 
MSL)

2. RA = Radar Altitude (in ft): distance between earth's surface and aircraft
Up to an elevation of 490 ft above earth's surface the RA is visualized by linear 
function, from 490 ft  on the visualization is logarithmic.
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3. VS Vertical Speed: Climb (+) or descent (-) rate in FPM (feet per minute)
4. Info to autopilot (autopilot direct, route or heading)

Direct: Magnetic course, distance in nm and calculated arrival time  
5. ref QNH 

Symbols for Attitude

1. Bank: Bank angle 10°, 20° (one dash each), 30° (triangle), 40°/45°/50° (dashes) and 
60° (triangle)  

2. BIRDY: Pitch trend = position in 2 minutes 
3. Pitch: - white symbol with flaps (calibrated in EFIS settings) 

- red symbol without flaps  
4. Horizontal line = altitude and elevation due to relation to the terrain 
5. Magnetic Track in °
6. UTC (reception from GPS)

1.7.5. Split Screen MT Terrain EFIS with Moving Map

→ EFIS → TERRN → SPLIT
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1.7.6. Split Screen MT EFIS with Moving Map

→ EFIS → HORIZ → SPLIT

1.8. Function keys – general info

• 10 buttons below the screen are always related to the function from the menu above

• The function keys always advises what should be obtained

• In this user manual the function keys are marked by the prefix  → 

• Alternate (toggle) function keys = if a function is activated the function key shows the 

opposite function to provide the way back – they are marked by  / 

• Main Menu => right button = AUX

• → BACK => step back to the last menu or to the main menu 

• → UP and → DOWN = move within a listing (always situated on button 8 and 9)

• → PREV and → NEXT = move from box to box

The functions for the buttons are only shown, if you purchased the rights to use the functions. 
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1.9. Symbols – general Info (Symbols on the Moving Map)

1.9.1. No Positioning from GPS

Position symbol in Map Mode = position in the center of the cross 
hairs.
If the chart is moved by using the green arrows in the upper corners 
the related cross hair gets colored green. The length of the green bar  
indicates the speed of the chart movement.

Warning Symbols for GPS reception (Flight Mode)
Satellite Acquisition but no positioning due to bad reception = 
improve the reception by moving to another position with improved 
sight to satellites 

GPS data distorted  = check the connection

No data from GPS = check the protocol 

1.9.2. Position Symbols

“Hover“ symbol
GPS position correct but ground speed < 2 kts 

Aircaft symbol
GS equals or greater than 2 kts
red dots marks the position

Helicopter symbol (alternative) → AUX → SETUP → HELI / JET
with revolving rotor

Trend vector

• optical projection of the track 

• magnetic track given on the arrow head

• distance between position (red dot) and arrow head given in 

the cyan diamond (see picture) 
or over the range rings if the course rose 

• Given in the chosen measurement unit (NM or metric)   

• Length is related to the scale of the map and whether it is 

shown center / off center mode
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1.9.3. Obstacles

Here is the symbol for version X.5.x and earlier. Symbolism from version x. 6.0 see chapter 
4. MT Obstacles / obstacle representation

Obstacle (e.g. tower) 150 m AGL or higher, lighted 

Obstacle (e.g. tower) lighted

Group of  obstacles lighted

Obstacle (e.g. tower) marked or non marked 

Group of obstacles (e.g. tower) marked or non marked 

Wind turbine

RED Lines Wires / cables 

BLUE Lines Power lines 

1.9.4. Linear / Frame Symbols 

• Cyan Direct

• White Route

• Magenta Active Leg 
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2. DIRECT / GO TO / NEAREST/ Defined Waypoints DEF

2.1. Direct

2.1.1. Direct from NAV Waypoint Page
→ navWPT 

→ DCT draws the DIRECT vector (blue)

• The blue direct vector remains at the position where it was inquired

• Displayed calculations follow the current position
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• The blue line is maintained where it was requested

• The calculations are made from the specific position specified in the main menu

• Update the DIRECT via → DCTupd or Hotkey D from the main menu
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Direct in Terrain EFIS 

Direct in Terrain EFIS + 2D Moving Map (Split Screen)
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2.1.2. Continuous DCT Update = Hotkey T

Continuous update of the DCT vector Instead of static display: 

• Hotkey T activates the continuous updating and liaises the DCT vector to the current 

position. 

• Pressing hotkey T again releases the DCT vector from the position. 

2.1.3. Temporarily Direct = DCTtmp

• → DCTtmp: current position is the origin of the DCT and the blue line between the 

origin and the current position is constantly updated. 

• By pressing → DCTtmp a TMPFIX waypoint is created simultaneously in the USER 

waypoint data base. It can be renamed if needed. 

2.1.4. Direct to Waypoint in Routes

Every waypoint in the route listings can be defined as DCT.

2.2. GOTO

→ GOTO

• “Jumping“ to the chosen waypoint = automatically change to the MAP Mode

• back to FLIGHT mode (positioning by GPS) by hot key K or Z 
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2.3. Nearest Airports

2.3.1. Hot Key N shows the 3 Nearest Airports

Chose the NEAREST airports by using the hot keys 1 or 2 or 3 according to the given 
numbers in the background of the green panels. 
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2.3.2. NEAREST Airport in 2D = Information and Symbols

• ILS Symbol - runway direction elongated to 7 nm to both sides of the thresholds 

Indication of 

• ICAO code or name of the 

airport, if ICAO code is n/a.

• distance and true bearing

• elevation in ft

• length of runway max in m

• INFO frequency (1. given 

frequency in navWPT 
database)

• blue DCT leads to the Airport 

Reference Point

2.3.3. NEAREST in 3D = virtual ILS to the runway

Light green frames mark a virtual ILS: 
length 7 nm from thresholds
angle 3,5°
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2.3.4. Possibilities to display NEAREST

Display in Full 2D: → EFIS → MAP

Display in Split Screen (→ EFIS → TERRN)
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Display in Full 3D:

2.3.2. Delete NEAREST
• press again hot key N
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2.4. Defined Waypoints REF using Radial / DME

Waypoints are defined by entering distance and True Bearing relative to a reference point .
This reference point is from one of the existing databases.

2.4.1. Pre-Settings for REF
1. Selection of the desired unit km or nm for the distance from the existing WPT

→ AUX
→ SETUP
→ KM = switch to metric system, input in km
→ NM = switch to nm system, input in nm

2. Define the database to select the reference point :
→ navWPT
→ DBASE

Selection of the desired database for the reference point
e.g. Selection of VFRIFR Database
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2.4.2. Define the RADIAL DME Waypoint

1. Selection of the reference waypoint within the preselected database, here VFRIFR.

2. → EDIT
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3. → REF

• Enter the name by overwriting the automatically proposed WPTxxx

• ID is automatically " co-written "

• the reference point is ( here BERN_BELP / LSZH ) and its coordinates ( here in LAT / 

LON system) is given above the ccordinates.

4. → NEXT → NEXT
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• Enter the True Bearing (3 digits)

• → NEXT

• Enter the distance in the selected unit (km or nm)

2.4.3. Work with RADIAL DME Waypoints

→ SAVE save the Radial DME defined waypoint in the USER waypoint database

→ GOTO display the def waypoint position on the map
or

→ DCT define a direct to def waypoint
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2.4.4. RADIAL DME Defined Waypoint based on a User Waypoint

Selection of the USER waypoint database → navWPT → DBASE → USER
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→ DEF

• automatically the next " free " WPTxxx will be proposed .

• accept it → SAVE

• or change it by entering a new name and overwrite the automatically proposed 

WPTxxx

• ID is automatically " co-written "

• the reference point (here BE14010 / BE14010 ) and its coordinates ( here in LAT / 

LON system ) is given on the screen

→ DCT
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3. Special Coordinates * 
(Note.: Additional module, not included in the basic software)

In addition to the display of coordinates in the Latitude - Longitude system 's more coordinate 
systems are available:

→ navWPT   → EDIT   → NEW / MODIFY

Input and

display of
Coordinates
in
Latitude /
     Longitude

Switch to another coordinate system, here Swiss Grid

The choices are
LAT / LON
UTM
SWISSG Swiss Grid

Once selected, a coordinate system remains active.
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3.1. UTM

The Universal Transverse Mercator (UTM) conformal projection uses a 2-dimensional 
Cartesian coordinate system to give locations on the surface of the Earth. The system 
divides the Earth into sixty zones, each being a six-degree band of longitude, and uses a 
secant transverse Mercator projection in each zone.

UTM

Conversion of waypoint coordinates in UTM

UTM
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3.1. Swiss Grid

The Swiss coordinate system (or Swiss grid) is a geographic coordinate system used in 
Switzerland for maps and surveying by the Swiss Federal Office of Topography (Swisstopo). 
The geodetic datum CH1903 (SRID 21781) uses as fundamental point the old observatory of Bern (46°57′3.9″N 
7°26′19.1″E (WGS84)), the current location of the Institut für exakte Wissenschaften of the University of Bern. In 
order to avoid errors during coordinate transmissions, the coordinates of this point are 600'000 m E / 200'000 m 
N. The 0 / 0 coordinate is located near Bordeaux, France. Though E coordinate is denoted as y and N coordinate 
x, E coordinate is the first axis of this Cartesian system, namely a point is denoted as (y, x). (Source: Wikipedia)

Swiss Grid

Swiss Grid is only valid for CH, abroad CH switched to Lat / Lon system.

Swiss Grid
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4. MT-Obstacles *

4.1. Coverage / Disclaimer and Updates

Database contains obstacles and line data (high-voltage cables and lifts) for the whole of 
Europe.

Disclaimer:
MT does not guarantee the completeness and correctness of the data.

The updates are performed via USB stick (data per download).

4.2. Displaying the obstacles: on / off

The obstacles are only visible from a certain zoom level onwards to ensure readability.
→ VIEW → ZOOM + → Display the obstacles from 200% on the ICAO map on a scale of 1: 
500,000 or on a map with a more detailed scale. Make sure that the base charts are 
arranged in a meaningful way.

To shown the obstacles: To disable the obstacles:
→ AUX → SETUP → OBST+ → AUX → SETUP → OBST-

The current setting is saved.

4.3. Representation of single or point obstacles

4.3.1. 2D representatiom

The obstacles are represented pictorially in a rectangle surrounded by a black border.
Unlit obstacles on white background:

 - Unlit obstacle

Lighted obstacles on yellow background: 

 - Lighted obstacle
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4.3.2. 3D view

An obstacle or - if specified - the icon is placed on the given coordinates.
At a greater distance, the obstacle is inflated and presented in a cuboid shape so that it can 
be better captured (this means it is larger than in reality). With an approximation to 2 km it is 
scaled with regard to the actual height of the obstacle and the visual representation is shown.

An illuminated obstacle flashes yellow (yellow point on the top of the obstacle).
Wind turbines are shown on a larger approach with a rotating rotor.

4.3.3. Table of individual obstacles (single or point obstacles)

Icon / 3D object Def.Hgt Symbolsin former versions Description / Notes
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Antenna

80 m Bell tower

Building

80 m Chimney / Smoke stack

80 m Communications tower

80 m Communication mast

80 m Cooling Tower

25 m Crane

30 m Gasometer

30 m Lighthouse

40 m Lighting pole
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20 m Mast

40 m Mineshaft

30 m Observation tower/post

60 m Offshore platform

Pole
Generic representation 
for single obstacle

40 m Silo

80 m

Height > 150 m

Lighted

Non-lighted

Group of lighted obstacles

Group of obstacles

Tower (generic)

30 m Water tower / reservoir
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2D:

3D: combined 
object

 

150 m

Wind turbine

Wind turbine

Many wind turbines in 
EAD are incorrectly 
referred to as "windmill"

40 m Windmill

4.4. Representation of cables and cables (linear obstacles)

4.4.1. 2D Representation

High voltage power lines are shown in yellow with red masts.
Cables and lifts are drawn in red.
Temporary cables / ropes are marked blue.

The "Wire Icon" - the image that specifies the type of cable - is displayed on the cable.

The masts of the high-voltage cables are red.

4.4.2. 3D Representation

The following components are required to display the cables in 3D:
1. The wires in the specified colors.
2. Masts and „auxiliary masts“ which guide the power lines and cables over terrain.
Here we have

46 MTEX/IA-05-05



Obstacle Type Colour 

of the 

cable

Type of masts Colour of 

masts

Representation for 

a distance bigger 

than 2 km

Representation 

at approximation 

< 2km

High voltage 

power line

yellow 1 yellow line 4 yellow lines

High voltage 

power line

masts coming from 
databases

red red cuboid red high voltage 
line mast

High voltage 

power line

auxiliary masts, 
necessary for 
guidance over 
terrain

blue blue cuboid red high voltage 
line mast

Cable/ rope red

Cable/ rope masts coming from 
databases

red red cuboid red mast + icon 

Cable/ rope auxiliary masts, 
necessary for 
guidance over 
terrain

blue blue cuboid red mast + icon 

Cable/ rope  

(temporarilly)

blue

Cable/ rope  

(temporarilly)

auxiliary masts, 
necessary for 
guidance over 
terrain

blue red cuboid red mast 

The „wire icon“ is displayed hanging on the rope.

4.4.3. Table of linear obstacle

Wire Icon Vertex 3D object / icon Def.Hgt Description / Notes

40/60 m Power Line
Wires: 4 x yellow

cable yellow

(Cuboid 1m x 1m x 
20m, Red) scaled to 
obs height

15 m Bridge
same as susp.bridge
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N/A Cuboid (1m x 1m x 
20m, Red) scaled to 
obs height

Cable
Wires: 1 x red

Generic representation for linear obstacle

cable red

30 m Cable Car ("Gondelbahn")
Wires: 1 x red

cable red

20 m Cable crane ("Materialbahn")
Wires: 1 x red

cable red

15 m Temporary material lift
Wires: 1x blue

cable blue

20 m Chair Lift
Wires: 1 x red

cable red

25 m Gondola Lift ("Kabinenbahn")
Wires: 1 x red

cable red
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12 m Ski-Lift ('"Schlepplift")
Wires: 1 x red

cable red

Cuboid (1m x 1m x 
20m, Red) scaled to 
obs height

15 m Suspension Bridge
Wires: 1 x red

Icon stretched beween poles and to pole 
height
Single wire on top of poles

cable red

-- Cuboid (1m x 1m x 
20m, Red) scaled to 
obs height

Telephone Line
Wires: 1 x red

cable red

Visualization in 2D
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Visualization in 3D
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5. CHARTS

5.1. Base Charts
Charts covering big areas  (like whole continents) 
→ CHART → BASE chose the desired chart by moving the the pointer with UP or DOWN 
and confirm with → USE.

5.1.1. Automatic switch to the next chart by using ZOOM

The display is horizontally split by a dashed line: 

Above the line:
Maps which are embedded in the logic switch function by pressing ZOOM

Underneath the line:
further charts

How to use the function “Automatic Switch To The Next Chart”
By pressing → ZOOM+ or → ZOOM-  in → VIEW menu the chart with the more (or less) 
detailed scale will be displayed automatically.

MTEX/IA-05-05 51



Requirements: 
The charts which you want to see automatically must be sorted in the area above the dashed 
line. Use → movUP and

→ movDN to move the charts. 

5.1.2. Order of the Charts

Choose the chart you want to move by → UP or
→ DOWN

Move the chart within the list by → movUP or
→ movDN

Above the dashed line → order of the chart is mandatory due to the logic!

The chart with the biggest scale to the top
then the next further detailed scale!

The 1. chart will be (for almost all customers using the system in Europe) 
EUROPE ICAO 1:500 000 ZOOM 50%

followed by  
EUROPE ICAO 1:500 000 (HI RES).

The 3. chart will be the next detailed e.g. 
GERMANY GENERAL CHART... 1:200 000 

and then e.g.
BAVARIA 1:50 000

Underneath the line → order of the charts is optional 

– order may be improved due to ease of access.

.MFD = Multi Function Mode = display without map

This chart option cannot be sorted into the logic section, since the MFD “chart” cannot be 
linked to a scale. It must be available for all ranges. 
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5.1.3. Base Chart Selection

By choosing a base charts from the upper section with → USE the automatic ZOOM logic is 
activated at the same time.

The subsequent ZOOM steps are:  
for EUROPE ICAO 1:500 000 ZOOM 50% 75% → 100%, then switch to 
EUROPE ICAO 1:500 000 (HI RES)
for this and all subsequent following charts: 75% → 100% → 150% → 200% 

The most detailed chart = the last chart above the dashed line can be zoomed in up to 600%. 

Charts underneath the line can be selected by  → USE 

– no automatic switch to the next chart!

- Zoom steps from 75% - 600% 

No chart – only gray background
The selected base chart does not cover the area of the position:

– check the position

– switch to another chart, either by selecting another chart or using the ZOOM 
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5.2. Single Chart Selection (Approach Plates are typical Single Charts)

→ CHART → SIN.CH
Select the category by pressing  → <<   or   → >>

• Selection: type identifier or name - just use the alphabetical keyboard

• the preview facilitates the orientation to select the suitable plate

•  → SEL : selection of the chart, it will be displayed automatically as soon as you will 

enter the area for which it is referenced.

• Coming closer to this area the single chart will initially be displayed embedded in the 

scale of the base chart. As soon as the single chart will be reached it will be displayed 
full scale automatically. 

• The info box informs about the currently selected single chart (use e.g. → navWPT) 

5.2.1. VFR Approach Charts (JeppView)

Select the category VFR by   → <<   or   → >>

• Enter the identifier or name of the airport  - just by using the alphanumeric keyboard – 
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and press → SEL  for select.

• Choose the right chart in the list by using  → UP and → DOWN

• Use  → SEL to select the chart. It will be shown automatically as soon as you will fly 

in the area. 

• Scale of ICAO chart, approach plate = single chart embedded
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Scale of the VFR Approach Chart 

• In case no VFR approach chart is selected: The airport which is located next to the 

current position is suggested. 

• In case a VFR approach chart is selected, the pre-selection is maintained

5.2.2. VFR Approach Plates of Deutsche Flugsicherung (German Flight Safety)

Category HELI-GER: helicopter landing sites (DFS), sorted by names
Category VFR-GER: Approach patterns (DFS) sorted by ICAO 4-Letter Codes

Name without amendment Approach pattern
Amendment _A and _A2 Area Chart
Amendment _T Taxi Chart

(for airports with runways longer than 2000m)
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5.2.3. Overview, Europe overview chart, USA overview chart

• category OVERVIEW: EUROPE (USA)

• to study long routes

• for weather briefing over a big area

• the Europe overview chart is technically laying on top of the base chart = e.g. ICAO 

chart. Since it is not easily possible to “leave” the chart (it is covering all Europe!) it 
has to be deselected:

• To deselect the overview chart use → CHART → HIDE or → UNSEL !
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5.2.4. Automatic Pre-selection of Single Charts

• If a route is present in the navRTE page (manually typed in or coming from BlitzPlan):
- SIDs for the departure airport are pre-selected 
- STARs and APPROACHs for the destination airport are pre-selected 

• If no route is present in the navRTE page:
- APT = Airport chart of the Nearest airport is pre-selected
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6. VIEW – Adjustment of the Display

6.1. → ZOOM  (see chapter 3.1. Base Charts)
Button provides info about what you aim:

→ ZOOM - zoom out 
→ ZOOM + zoom in 
→ 100% chart in size 100% scale

6.2. Aircraft Symbol Center or Off Center 
→ CENTR / → OFF-C Move your position center / off center

6.3. Chart Track Up or North Up
→ ROTATE / chart s displayed / rotated to track   or 
→ N-UP north up

The 3D Relief Dynamics formerly placed in this menu is now here: 
 → EFIS → TERRN  

6.4. → MFD

Switch to MFD Mode = automatic selection of the .MFD “map”.
→ ZOOM+
→ ZOOM -
→ 100% = 472nm Center Mode und 600nm im Off-Center Mode

back to the chart  → MAP

Attention: 
TCAS- and stormscope data are display relative to the position. It is not possible to show the 
warning data if the aircraft is not moving.
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Attention:
TCAS and Stormscope data are determined by the board sensor system.
If there is no movement and therefore no heading, the determined data can not be displayed 
(positioned), even on the map. See instructions in “Installation manual”.

6.4.1. Why do we need the MFD mode?

• To display long routes 

• Weather briefing along the route

Weather briefing for big areas  

• Enroute layer without the chart information

• In general to determine information without the chart, especially for bigger ranges
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7. NAV Waypoint Page → navWPT

7.1. Standard data bases

VFR/IFR data base 

Search input by 4 letter identifier

Search input by name
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7.1.1. Hints for waypoint search

• you type in the field in the right part of the screen

• check in the left part, whether it is the correct waypoint

• check coordinates or identifier 

7.1.2. Mistype?

• For mistype to empty the field → DOWN, then new entry    or 

• → CHAR → DEL to delete only 1 character

• Use  → CHAR (character) for special characters (. , - / @ )

7.1.3. Switch to other waypoint data bases

• → DBASE selection of data bases 

→ VFR/IFR = navigational data base worldwide 
detailed info for European airports

→ USER = open USER data base for your own WPTs
→ VFRRPT = VFR Report Points

It is possible to integrate further data bases. 
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7.1.4. Direct (q.v. 2.1.)

• → DCT select the destination → NavWPT from one of the data bases → DCT

• → DCTupd direct update (only available if the destination is already selected) 

also hot key D

• → DCTtmp temporarily  direct 

7.1.5. Delete Direct 

• use → AUX → SETUP → DCT-

7.2. User Waypoints (use → EDIT)

7.2.1. To enter a new waypoint   → NEW
• current position is automatically entered 

• new waypoint named WPTxxx is offered

• type in the new name (the system name will be deleted) 

• → NEXT type in the identifier: it will be displayed on the chart (flag)

• → SAVE

7.2.2. Modify an existing waypoints → MODIFY

• type the correct data and → SAVE 

7.2.3. Delete a waypoint which is no longer needed → ERASE
this deletes the waypoint definitely from the data base. 

USER waypoints can be DCTs or parts of the routes. 

7.2.4. REF Waypoint defined by Radial DME (see 2.4)
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7.3. Further Waypoint databases

7.3.1. VFR reporting points

The VFRRPT database contains VFR reporting points in Europe.
Search for the the airport name (not the ICAO identification!).
Further selection via the IDENT field in which the specification (e.g., ECHO, NOVEMBER, 
etc.) is found.

Procedure for inserting a waypoint from the VFRRPT e.g. as DIRECT:
→ navWPT → DBASE → VFRRPT → Select the point → DCT

Attention: 
The selected database remains active. If you want to use a waypoint from one of the other 
databases, you have to change the database again.

→ navWPT → DBASE → Change the database (for example to VFR IFR) → Select the new 
waypoint → DCT.

7.3.2. Streetdata

Site and streetdata are especially used for airborne rescue operations.

Here an example of the database „Bayern“:

→ navWPT → DBASE → BAV S
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Selection of the city or the location using the keyboard → SEL
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Selection of the street / address 

This waypoint can be used as a „normal“ waypoint, for example as a direct:
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8. NAV Route → navRTE

8.1. Compilation of a route
→ navRTE initially “blanc sheet“

Now just tpye the 1. character of the WPT (name or identifier)!

• INS WPT PAGE 
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• insert of the complete name or identifier = just continue typing

• → INS = insert 

• → UP and → DOWN  move up / down in the list: 

Mark a WPT: The next waypoint will be entered above this position.

Repeat this procedure till you entered all WPT for the routing.

• → DEL delete a single WPT from the route

Every route WPT can be used for 

• → GOTO jump to this position on the chart

• → ICPT intercept: for route optimizing

• → DCT Direct

8.2. Switch to another data base

Type the 1. character of the WPT you want to select!

• INS WPT PAGE 

• → DBASE select → VFR/IFR

→ USER

• input / selection by identifier or name = continue typing

• → INS = insert 

8.3. Insert of current position in the flightplan

To insert the current position or the position on the chart in the route: 
Move the chart to the desired position (approach WPT, airspace or others) by using the arrow 
keys or touch function. 

• → navRTE

• set the active position marker to the WPT above which you want to enter the position 

by  → UP and → DOWN

• type any character key  (A, B, C, …) =  INS WPT PAGE 

• → INSPOS Insert Position (coordinates given in the INFO BOX)

• coordinates are inserted in the route
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8.4. Save, Load, Modify and Delete → ROUTES

Routes can be 

• saved → SAVE

• load → LOAD

• modified

• deleted → ERASE = deleted from the unit completely 

Routes can contain IFR elements - the name VFR routes is fact not very precise.

!!! IMPORTANT !!!
 Additive loading of route segments 

 Clear the route page before compiling a new route: 
→ AUXrte → CLR     or    → DEL (multiple presses if needed) 

Blitzplan routes are always loaded exclusively. 

8.5. → AUXrte – further functions for planning a route

• entry of cruise flight levels and the cruise speed (type the numbers ) for EET 

calculation

• → CLR delete all WPTs from the route

• → INV invert the route (only customized route, no procedures)

• → copy ALT copy altitude from GPS

• → copy GS copy ground speed from GPS
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9. Further Functions → AUX

9.1. → TRACK: Track Saving and Automated Logbook

9.1.1. Track recording   → AUX → TRACK

Tracks are recorded as soon as the GS > 2 kts
→ SAVE save the track by typing a name 
→ PLAY replay the track in time lapse (→ NORM or → FAST)
→ ERASE delete completely
→ CLEAR delete the track points from the display

9.1.2. Logbook   → AUX → TRACK
→ LOG = Log book
→ EDIT work with the flight logs

separate buttons for special characters
→ PREV and → NEXT = move from field to field
→ SAVE the entries (back to EDIT page)

→ INS insert a new line = new flight
→ ERASE final delete of an entry line 
→ TXT file export, see 7.3 → AUX → SYS
→ UP and → DOWN = selection of an entry for editing

9.2. → SETUP: Adjustment / Indication of Configuration Parameters

9.2.1. Software version
→ AUX → SETUP→ VERSION the current version number is displayed

1 x press: SW version
2 x press: version of operating systems

and further details

9.2.2. Switch to metric measurement units

→ AUX → SETUP → KM switches to metric units (back with → NM)
→ AUX → SETUP → NM switches to nm (back with → KM)
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9.2.3. Date of the Obstacle Data
→ AUX → SETUP → DATES

9.2.4. Hiding of Info to Clear up the Screen (i.e. Delete of the DIRECT)
→ AUX → SETUP → WPT- /+ show / hide of User WPT symbols 
→ AUX → SETUP → DCT- un-select  the Direct
→ AUX → SETUP → OBST- /+ hide / show the obstacle symbols 

9.2.5. GPS Selection

→ GPS selection between EXTERN and INTERN
→ EXTERN

• INTEGRAL GPS (4800, NMEA)

• FAST INTEGRAL GPS (9600, NMEA)

• TRIMBLE (9600, AVIATION)

• KING KNL90 (9600, AVIATION)

• GARMIN 430/ 530 (9600, AVIATION)

• UNIVERSAL FMS (9600, AVIATION)

• FLARM (38400, NMEA) (ONLY FOR COMBINED TCAS 

DISPLAY)
→ INTERN integrated SIRF 4 GPS

9.2.6. Selection of Phone / Download

→ AUX → SETUP
→ DIAL UP selection for downloads (radar pictures / BlitzPlan)

→ USE selection of source
→ RadDWD / 

RadENH download of radar pictures (MT-Satellite Radar)
→ RadAuth input of authetication data for MT-Satellite Radar

→ HNG-UP manual disconnect of the data connection

NOTE: BlitzPlan will hold the line for 180 sec. to provide a fast access to further downloads. 
If the works is already done it is advisable to hang up manually to save costs, especially for 
the use of Iridium.  
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Arranging the required telephone sources

Selection via → UP
→ DOWN

Move the selection within the list via → movUP
→ movDN

Above the line: The telephone source (s) that are necessary for the setting (usually 1 
satellite phone and a SIM definition).

Below the line: More sources optional.

9.2.7. Switch between Jet or Heli Symbol 

→ JET  → HELI
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9.3. → AUX→ SYS → BACKUP / Restore or Transfer of User Data

→ AUX→ SYS
→ BACKUP a current backup of:

• USER waypoints / routes / tracks

• Logbook

• Blitzplan FPL list and log in data

• saved PDFs

• current settings for display and system 

Use an USB Stick (FAT32 formatted)
Report of progress and end of backup on the screen.

→ RESTORE restores the data from the backup USB stick
to synchronize several MT-VisionAir systems

9.4. → AUX→ RESET

Restructuring of the data bases

• followed by an automatic restart of the program (duration ca. 30 sec.)

• fixes very rare data base problems 
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10. Flightplan / Route Transmission *

10.1. Transmission of a Flight plan from Garmin 430 (XFILL- Option)

Prerequisite: Connection via COM Port to Garmin 430. 

→ navRTE → XFILL
Transmission of the current flightplan at the time of the crossfill request into the MT.
 Displayed in the Nav Route Page.

The functions DCT / ICPT / GOTO can be used to every waypoint.

10.2. Transmission and Displaying of a User Route from an External 
Flightplanning Program

Transmission via USB stick.

Prerequisite: the USB stick has to be be formatted FAT32. 

10.2.1. Work with external Flightplanning Program
• Compile a route

• Save on the USB stick in GPX format – directly in the root directory 

• The name of the route should be maximum 8 characters (e.g. 4Lettercode Departure 

+ 4Lettercode Destination  =  EDJAEDNY

10.2.2. Transmission to MT-VisionAir X

Insert the USB stick into any USB connector of the MT-VisionAir X. We recommend to use an 
external USB port via central connector, so the unit itself remains installed.
The unit may be already running, there is no need to shut it down nor restart.

→ navRTE → ROUTES → IMPORT

List of routes on the USB stick is displayed and imported. 
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Unplug the USB stick after import. 
CAUTION: Any route files already present on the VisionAir X with the same name will be 
overwritten without confirmation

10.2.3. Load the Route

→ navRTE → ROUTES → LOAD

The imported routes can then be found in the navRTE - ROUTES page, ready to be loaded 
into the navRTE page using the LOAD button:

10.2.4. Display of the Route in the NAV RTE Page and on the Chart
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On the chart:

10.2.5. Error Messages using IMPORT Function

When giving the IMPORT command and no USB stick has been inserted, or if the USB 
memory cannot be read, the unit shows the following message:

In case no route files (in known format) are found:
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When route files are found but cannot be interpreted:

10.2.6. Example of GPX file recognized by the VisionAir X

<?xml version="1.0" encoding="UTF-8"?> 
<gpx xmlns="http://www.topografix.com/GPX/1/1" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" version="1.1" 
xsi:schemaLocation="http://www.topografix.com/GPX/1/1 
http://www.topografix.com/GPX/1/1/gpx.xsd"> 
  <rte> 
    <name>EDJA-EDNY</name> 
    <rtept lat="47.988822" lon="10.239483"> 
      <sym>EDJA</sym> 
      <name>Memmingen</name> 
    </rtept> 
    <rtept lat="47.903333" lon="10.266667"> 
      <sym>JAS</sym> 
      <name>EDJA VRP SIERRA</name> 
    </rtept> 
    <rtept lat="47.691277" lon="9.841347"> 
      <name>Wangen</name> 
    </rtept> 
    <rtept lat="47.608333" lon="9.586667"> 
      <sym>NYS</sym> 
      <name>EDNY VRP SIERRA</name> 
    </rtept> 
    <rtept lat="47.671317" lon="9.511486"> 
      <sym>EDNY</sym> 
      <name>Friedrichshafen</name> 
    </rtept> 
  </rte> 
</gpx>

NOTES:
1) The <sym> field determines the waypoint identification as shown in the VisionAir X

2) The <name> field is ignored, unless the <sym> field is absent. In this case the <name> field is used as 
waypoint identification (see "Wangen" in the example route)
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11. MT-IFR Complete Package *

11.1. MT-ENROUTE Layer *

Display of the Airway-Layer
→ CHART → AWY+ → BACK

Hide the Airway Layer
→ CHART → AWY- → BACK

11.1.1. MT-Enroute Layer without chart (MFD mode)

To only see the Enroute Layer :
→ CHART → AWY + → BACK and
→ VIEW → MFD

Set a suitable scale by using the ZOOM function. If the scale is too large the Enroute map is 
not shown, the info would be unreadable.
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11.1.2. MT-Enroute Layer over the ICAO charts

Back to charts
→ VIEW → MAP

11.2. Electronic Flight Bag

Select IFR JeppView charts
→ CHART  → SIN.CH    Single Chart Selection 

Categories are:

SID Standard Instrument Departures
Type: not referenced, no moving maps due to drawing not to scale

STAR Standard Arrivals
Type: not referenced, no moving maps due to drawing not to scale

APPROACH Standard Approaches  
Type: Moving Maps 
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APT   Airport Charts
Type: Moving Maps 

OTHERS Further charts 

11.2.1. Selection / Alteration of an active airport

Conditions: 
If a route is entered in  → navRTE:

- departure airport is active for category SID
- all other categories are allocated to the destination airport    

Alteration of the active airport by typing the identifier or name = just type 

IFR APT SELECTION → complete the identifier / name of the airport or select by → UP or → 
DOWN  

Select with → SEL 

11.2.2. Selection of a Category   SID   STAR   APPROACH   APT   OTHERS 

Select a category by     → <<    or   → >>

11.2.3. Selection and Displaying of a SID or STAR or Information

Choose the right chart within the list with  → UP or → DOWN.

The title of the chart is displayed in the header above the maps preview, here ALBIX 1C, 1D 
& 2R DEPS.
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Select the previewed chart → SEL

Charts which are not referenced can be displayed  
→ SHOW
and zoomed
→ VIEW → ZOOM+   or   → ZOOM-

MTEX/IA-05-05 81



To end the displaying of the chart  → CHART   →  UNSEL
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11.2.4. Selection of an Approach or Airport Chart 

• choose the category by   → >> 

• choose the chart within the list by  → UP or → DOWN  or typing the name 

• check the preview 

• check the title of the chart  given in the header

Select by  → SEL

As soon as the area for this chart will be arrived the chart will be displayed 

– initially embedded in the base chart and as soon it is really arrived

– to scale as a moving map. 

Even if the distance to the chart is too big and it cannot be displayed it is already prepared 
for the use and will come up automatically. 

Attention: If the ground speed is lower than 65 kts, the corresponding AIRPORT CHART will 
be selected automatically.

Advantage: No need for further entries during landing phase.
Disadvantage: Approach chart may not be displayed long enough (slow approaches). 
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2D map

Split screen  → EFIS → TERRN → SPLIT
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11.2.5. Briefing with Approach Charts

As soon as an Approach Chart is selected the main menu provides briefing possibility:

→ TVIEW = Top View
→ PVIEW = Plan View
→ VVIEW = Vertical View
→ POS = back to current position and moving map function

→ T VIEW = to read information above the map 
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→ P View = map itself – centered and fully readable

→ V View = vertical approach information 

→ POS = back to current position and moving map function 
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11.2.6. Automatic Switch to corresponding Airport Chart

Ground speed < 65 kts → automatic switch to the APT Chart

Here display split screen with MT Terrain EFIS.

11.2.7. Procedures 

IFR procedures are no longer maintained or updated.  
Possibly existing procedures are outdated and not for navigational use.

  

11.2.8. MT–Blitzplan * 

Separate user manual for Blitzplan can be downloaded here: www.blitzplan.de. 
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12. MT–EFIS *

12.1. Basics

Pitch rotation along the lateral axis 
Roll rotation along the longitudinal axis  i.e. the bank.

    
Pitch of the aircraft is combined flightpath and angle of attack AOA. 

The angle of attack is the angle between flow direction of air particles and reference axis of 
the aircraft. The flow direction is the opposite of the flightpath. 
The angle of attack depends of several variable parameters. 
It is essential to customize some parameters individually for each airplane.
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12.2. Parameters for EFIS  / Input Values

To enhance the accuracy of EFIS display some values have to be determined during a 
calibration flight. 
1. AOA Angle of Attack depending on the speed.
To read the Angle of Attack on the on board gyro horizon, the flightpath has to be horizontal, 
then AOA matches the pitch. 
This is achieved at a horizontal flight without a change in altitude. A total of eight measured 
values is necessary: 

not MTOW (maximum take off weight) but current weight for calibration flight
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12.2.1. Values without flaps

Min Speed Clean:
Minimum speed above stall speed = ca. 5 kts above stall speed

AOA Clean:
Corresponding value of the angle of attack in degrees for minimum speed clean. 
Read it directly on the artificial horizon during horizontal flight.  

If you look at the artificial horizon below it would be read as 4°. Copy this value to field “AOA 
CLEAN”. Copy the corresponding “MIN SPEED CLEAN” from the airspeed indication (IAS). 

Max Speed Clean:
IAS at horizontal flight with no indicated pitch. 
The pitch symbol coincides with the line of the horizon = neutral line. 

11.2.2. Values with flaps 

Measurement according to the description for evaluation without flaps. 

Min Speed Flaps:
Minimum speed above stall speed with flaps (ca. 5 kts above stall speed)

AOA Min Speed Flaps:
Corresponding value of the angle of attack in degrees for minimum speed with flaps.

Max Speed Flaps:
Maximum speed with flaps 
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AOA Max Speed Flaps:
Corresponding value for angle of attack (in degrees) for maximum speed with flaps. 

The pilot decides whether to choose: 

– Max Flap Setting     or

– i.e. To &  Approach Flap Setting.

The white symbol corresponds to the chosen value setting. 

Weight:
Take off weight for the calibration flight (in kg). 

This values in combination with the GPS data allow a continuously calculation of AOA and 
current pitch. 
2 different symbols for the different settings: 

- red pitch symbol for the flight without flaps 
- white pitch symbol for the flight with flaps. 

The following diagram corresponds with the configuration from the example above. 
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12.2.3. Example for a Calibration Flight

The following procedure is an example for a calibration flight:

At medium airspeed a horizontal flight is set without a change in altitude. Now the speed is 
reduced as far as possible (e.g. 1.1 x stall speed). Copy the measured data for Angle of 
Attack and IAS in a prepared table.

Now accelerate until you can see the zero-line on the (adjusted) on-board horizon. This value 
is copied into the table as well. 

The same maneuver is flown with flaps set. There you accelerate until you reach the maximal 
flyable speed and then copy the pitch. 

The altitude of the flight is not relevant, but it is advantageous to perform the calibration flight 
in a stable atmosphere.  

After that you can easily enter the data into the MT unit. The predefined default values will be 
overwritten and the new data will be saved. 

With EFIS activated you find the input menu when you press → SET.
To save the data, use → STORE.

Take-Off Weight: [kg]

Min Speed Clean,  IAS = [kts] AOA Clean = [deg]

Max Speed Clean, IAS = [kts] AOA = 0 [deg]

Min Speed Flaps,  IAS = [kts] AOA Min Speed Flaps: [deg]

Max Speed Flaps, IAS = [kts] AOA Max Speed Flaps: [deg]

12.2.4. Settings Before Each Flight

→ FLIGHT   input mask for wind and weight. 
These data should be as up to date as possible as they influence the dynamic calculations. 
According to feasibility and circumstances this data can be updated during the flight as well. 
But even with a poor calibration, the display stays "relatively" correct. 
Only the absolute calculation of the pitch shows a minor discrepancy.
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Enter the current data of wind speed, direction of wind and the weight. As a default value the 
weight from the calibration flight is entered. If no data is entered, the system calculates with 
wind=0 and the default standard weight. The settings can be updated during the flight.

Save values by pressing → STORE.

12.2.5. QNH-Display

By use of the exact height measurement of the GPS and the barometric altimeter of the 
aircraft the current QNH can be calculated very accurately. For this you set the atmospheric 
pressure of your altimeter to 1013 hPa. Open the input mask with the button → QNH. 
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Now you copy the value from the altimeter in feet (Flight Level Display). After pressing → 
STORE the current reference QNH is calculated for the area you are flying.

12.3. How to read the EFIS information 

To show several flight conditions at the same time there are several reference markings. In 
the horizon there are 3 different symbols:

1.) The red aircraft symbol is the reference for Pitch under normal  conditions (without 
flaps). It is visible from the minimal clean speed onwards.

2.) The white symbol shows the pitch attitude with the position of the flaps for which the 
EFIS was calibrated. It is visible from the minimal speed with flaps set to the maximal 
speed with flaps set. The values 1.) and 2.) also depend on the take-off weight.

3.) The blue symbol visualizes the angle of the flight path. It stays always in the center of 
the pitch-scale where the Flight Path Angle (Slope) can be read.

At a very low speed only the white symbol is shown. When the red marking is added, the 
display references itself to the pitch without flaps. This is the reason for a skip in the display.
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In turning flight:

The roll angle is shown on the white scale at the top of the display. The gradation has the 
following increment (from the inside to the outside):

− Roll Angle = 10 degrees (first narrow bar)
− Roll Angle = 20 degrees (second narrow bar)
− Roll Angle = 30 degrees (first triangle)
- Roll Angle = 40 degrees (short bar)
− Roll Angle = 45 degrees (longer bar)
- Roll Angle = 50 degrees (short bar)
− Roll Angle = 60 degrees (second triangle)

12.4. Elements in the Display

1

2 10

3
9

4

5

6 7 8

1) The value in the display corresponds (with correct calibration) to the Angle of Attack. 
2) The yellow bar visualizes the speed trend. That implies the expected acceleration in 10 

secs (+–  kts).
3.) This is the display for the ground speed (kts) and the CAS (kts). The CAS it the air 
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speed calculated by EFIS, which depends on the ground speed, change of height, air 
density and wind. 

4.) The Flight-Path-Angle corresponds to the flight path, i.e. the slope of the aircraft. The 
point of the aircraft-symbol shows the current value. In the example the aircraft is in a 
horizontal position, so the slope (FPA) is zero.

5.) The indicator of the Two-Minute-Turn shows the mark where the turning rate of a 360° 
turn is exactly two minutes.

6.) Below the display of the horizon is the display of the Mag Track. This shows the 
current track over ground. 

7.) After input of the current pressure (see chapter 4) this window shows the reference 
value of the current QNH.

8.) RA = Radar Altitude. The value shown here is the distance between the aircraft and 
the ground. In order to achieve a high sensitivity when flying close to the ground, up 
to a height of 490 ft above ground the altitude data is visualized by a linear function. 
Above 490 ft the display switches to logarithmic. 

9.) This shows the true altitude over MSL. 
10.) Variometer in right part of the screen  = climbing rate respectively descending rate in 

ft/min.

12.5. Error Messages

− NO DATA: No Data received by EFIS 

− LOADING DATA: Data is loading (about 2 sec after being switched on)

− display crossed out red low speed, minimum 39 kts

− ALTITUDE ERROR: Wrong or no ALTITUDE data 

− SIGNAL ERROR: Error in data transmission respectively
wrong GPS-data

12.6. Limitations

EFIS does not work properly for low speed aircraft (e.g. gliders) and not for aircraft which can 
be subject to uncoordinated conditions of flight (e.g. helicopters).

Inaccuracy in the display can occur...

− ... because of  evident changes of the wind conditions coinciding with a low airspeed
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− ... yawning flight (e.g. engine failure in a twin aircraft)

− ... in the post-stall area

− ... with some acrobatic flight maneuvers

12.7. WAAS/ EGNOS

With systems like EGNOS and the fully compatible system WAAS, correction signals are 
transmitted on the frequency L1 of the geostationary satellites like Inmarsat or Artemis 

This correction data is acquired from a multitude of stationary ground stations which collect 
the ionospheric induced run time errors within their reception area and calculate the 
correction factors for different geographical areas. 

This allows the EGNOS / WAAS compatible GPS receivers to determine the additional run 
time effects of the signals in the ionosphere and the resulting divergence of the positioning is 
less than 1 m. 

Without this correction data the standard accuracy of civil GPS lies between 5 m and 15 m. 

EGNOS is a joint project of ESA, the EU and the European air traffic control Eurocontrol, 
which initialize this project together as European Tripartite Group (ETP). The European 
Satellite Service Provider (ESSP) will put EGNOS on the market and run it as a business.

At the moment the system is in transition from test mode to routine mode. 

List of satellites with an EGNOS transponder:

ARTEMIS (PRN 124; ID 37) 

Inmarsat AOR-E (PRN 120; ID 33) 

Inmarsat IOR-W (PRN 126; ID 39)  
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13. MT-TERRAIN EFIS *

The combination of internal position sensor with the positioning on the Fast Integral GPS 
enables an indication of the attitude in real time.
The presentation is in full- or split-screen, with or without terrain representation (Terrain or 
Horizon).

The explanation of the screen representations in Chapter 1.7.
The limitations are to re-evaluate the addition of the internal position sensor. 
MT-TERRAIN EFIS has been successfully tested in several helicopter flights. 

13.1. Requirements for MT-Terrain EFIS

The internal calibration must be done at the factory and MT have taken the appropriate 
activation.

Use in the cockpit:

• The MT-VisionAir  must be firmly attached to the aircraft. An installation on the 

controls is not possible.

• The MT-VisionAir X must be mounted aligned to the aircraft axis. 

No deviation angles to latitude axis = y axis = roll 
and yaw axis = z axis = heading.

• A deviation angle to the lateral axis = x axis = pitch

can be compensated. 

13.2. Calibrating of Deviation to Pitch Axis (Button A)

It is possible to display the aircraft attitude (not that of the MT-VisionAir!) on MT VisionAir X 
systems that are not mounted completely vertically.

After installation of the MT-X VisionAir the "Mounting angle" must be determined:
Select → EFIS → HORIZ → Press the button "A".
The MT-VisionAir will confirm the measurement with a message.
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IMPORTANT: The aircraft must be on a level surface and must not be moved.

"A" in → EFIS → HORIZ is deactivated as soon as the GPS Speed > 5 kts in order to avoid 
unwanted calibration in flight.

Should it become necessary due to compensate an unusual situation on the ground (eg tail 
dragger ...), give us a call.

The calculated mounting angle is stored. To adjust this setting is only necessary again if the 
installation situation changes or the MT-VisionAir X will be installed in another aircraft.

13.3. Adjust Flight Attitude Display with GPS Attitude (Button R)

“R” adjusts the displayed flight attitude with the flight attitude from the Fast Integral GPS.,

13.4. How does MT-Terrain EFIS Work?

• MT EFIS Terrain combines flight attitude data from the internal sensors with flight 

attitude data based on the Fast Integral GPS. The sensors provide immediate 
response to change in position, the GPS provides a stable attitude with slow 
response.

• The MT TERRAIN EFIS starts at a speed of about 40 kts. At lower speeds, the 

instrument is marked with a red cross and a level attitude is shown (this value is 
assumed).

• To get a reliable result, it is important to define appropriate speeds and angles of 

attack:
→ EFIS → HORIZ → SET 
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14. MT-TAWS Terrain Alert and Warning System *

14.1. Display of TAWS relative to the Position

Parameter
red opaque terrain - (read “position minus“) 200 ft and higher
yellow semi transparent terrain - 200 bis - 400 ft
green semi transparent terrain - 400 bis - 600 ft

14.1.1. Warning in Flight Mode relative to GPS Altitude

→ TAWS → ON on the screen: TAWS rel = relative

On the chart (ICAO 1:500 000): 
→ TAWS → ON, relative mode, FLT mode

TAWS cannot be displayed:
- if altitude is not transmitted 
- without movement in flight mode
  

Missing altitude causes a completely red screen!
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→ TAWS → ON + → EFIS → TERRN: full screen, relative mode, FLT mode

• In MT Terrain Mode the warning colors the 3 dimensional terrain 

• Here display in birds view : use hot key V

→ TAWS → ON + → EFIS → TERRN:  Split screen, relative mode, FLT mode + birds view = 
hot key V.
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14.1.2. Adjust the Elevation Warning Level in MAP Mode by → ALT +  / → ALT -

• Use it for simulation of cloud base 

• 500 ft steps to adjust the simulated altitude 

→ TAWS → ON + → EFIS → TERRN: Split Screen, TAWS relative, MAP mode.

14.2. TAWS as Synthetic Vision

Display of Synthetic Vision under 2 conditions possible:
→ TAWS → ON   +   → VIEW → MFD

Back to TAWS on the “real” chart:  
→ VIEW → MAP
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14.2.1. Relative Warning with Synthetic Vision

→ TAWS → ON + →  VIEW → MFD + → EFIS → TERRN (here V for birds view)

→ TAWS → ON + → VIEW → MFD + → EFIS → TERRN, Split Screen (here V for birds 
view)
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14.2.2. Display of Terrain in Synthetic Vision (TAWS absolut)

→ TAWS → ON → ABS   +   → VIEW → MFD
Different possibilities to display the terrain:  

Full Screen (→ EFIS → MAP)

Split Screen (→ EFIS → TERRN)

104 MTEX/IA-05-05



Advantage of Synthetic Vision 

• Zoom out possible to see big ranges

• Overview over long routes

→ TAWS → ON → ABS → Zoom – (press several times) 

Zoomed in for detailed information (→ VIEW → ZOOM+)
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→ TAWS → ON → ABS   +   → EFIS → TERRN

Advantage of this display:
Combination of detailed view in 3D and overview over the routing. 

De-activate TAWS by  → TAWS → OFF.
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15. MT-Satellite Radar → RADAR

15.1. Authentication for Downloads of Radar Pictures:
→ AUX → SETUP → DIAL-UP → AUTH

I → CAPS capital letters 
→ NEXT next field
→ PREV previous field
→ DEL delete 1 character
→ SAVE save input of authentication data
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15.2. MT-Satellite Radar Standard

15.2.1. Adjust MT-Satellite Radar Standard

→ AUX → SETUP → DIAL-UP → RadDWD

(note: button shows now RadENH)

15.2.2. To Start MT-Satellite Radar Standard

→ RADAR Start of the downloads 

2 Operating Modes 
→ ON (→ RADAR → ON)

– starts an automatic dial up and download process for the radar pictures in

time intervals (at time every 15 min)

– finishes the process with an automated hang up.

→ M.LOAD (→ RADAR → M.LOAD)
Manual on time download – dial up, download, hang up 

Stop the downloads: 
→ RADAR → RAD OFF
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15.3. MT-Satellite Radar Enhanced *

Full European Coverage 
Combined with lighting data 

15.3.1. Adjust MT-Satellite Radar Enhanced

→ AUX → SETUP → DIAL-UP → RadENH

(note: button shows now RadDWD)

15.3.2. To Start MT-Satellite Radar Enhanced

→ RADAR To start the downloads 

MTEX/IA-05-05 109



2 Operating Modes 
→ RADAR → ON

– starts an automatic dial up and download process for the radar pictures in

time intervals (every 15 min)

– finishes the process with an automated hang up.

→ M.LOAD (→ RADAR → LiveRad)
Manual download in between the regular automatic interval 
 – dial up, download, hang up 

Stop the downloads: 
→ RADAR → RAD OFF

15.4. Functions in RADAR Menu for optimized Handling

→ SHOW / → HIDE show or hide the radar picture overlay
→ ZOOM+ and ZOOM - 
→ MFD switch to Multi Function Display for display for big ranges

back to the chart by → MAP
→ DIAL-UP selection of the phone / download option

→ UP and → DOWN → USE
→ HNG-UP hanging up - normally the hanging up is done automatically. 

- only necessary in case the download process
 is lasting too long (i.e. for bad reception)

15.5. Display of the radar pictures

Intensity of precipitation in MT color scale.

The traffic light  colors allow an intuitive understanding of the intensity and danger

green = in the clouds: coarse dropped condensed humidity 
below the clouds: little rain

yellow = medium intensity of precipitation 
red = strong precipitation, likely forming of CB s
blue = extreme strong precipitation, very active CB s, hail 
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On the chart 

In MFD Mode (here together with Enroute Layer)

Further optimizing displaying the radar  → VIEW
→ ZOOM+  and → ZOOM- to evaluate the radar pictures along the routing 
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→ CENTR / → OFF-C  position centered or off centered 
→ ROTATE / N-UP Track UP or chart north up 

Info for the radar layer on the screen 
Info to the download process  

15.6. History – Recording of the Radar Pictures

The radar pictures are saved and can be displayed consecutively:  
→ << back to older radar pictures
→ >> forward to more current radar pictures 

• allows a weather briefing over a longer period, i.e. already for preflight briefing 

• allows also a (cautious) estimate of weather development 

15.7. Terminate MT RADAR

→ RADAR → OFF

• The status windows stays as long as the radar picture is displayed.  

• To terminate the display of the radar picture use  → RADAR → HIDE
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16. MT-TCAS *

16.1. Interface to Avidyne TAS 600/610/620 series

Dynamic synchronized simulation technology DSS

As soon as other air traffic has been detected in the vicinity, a simulator is activated in 
parallel. It is calibrated to and analyzes the flight characteristics of the respective aircraft. 
This enables the pilot to determine at a glance the direction and speed (15-second arrow = 
trend vector) of approaching aircraft. 

Each aircraft with transponder recognition is individually interrogated and analyzed by the 
sensor. This produces a transparent picture of surrounding air traffic. 

The critical cylinder

Moving Terrain places a ”critical cylinder” around your own aircraft. 

• The radius of the critical cylinder is 1 nm. 

• Its height is 1000 feet. 

• The vertical position of your own aircraft in the critical cylinder depends on the current 

flight path: 
Own flight path Relative altitude in feet

above below
Normal flight > 500 < -500
Climb > 1000
Decent > 0 < -1000

MTEX/IA-05-05 113



Symbols

Surrounding traffic is shown by flashing lights (more conspicuous, esp. on chart) and color 
coding:

blue - above the critical cylinder

brown - below the critical cylinder

red - within the critical cylinder, dangerously close

white - same altitude as the critical cylinder, but outside the danger zone

• Displayed as an airplane (SQUAWK shown in white box) 

• If the speed of another aircraft is too low to represent its speed, it will appear as a 

diamond instead of an airplane. 

• Stated altitude is relative to your own aircraft (in 100 feet). 

• Red arrow pointing upwards: Climbing faster than 500 fpm

• Red arrow pointing downwards: Descending faster than 500 fpm

Speed vector:
The 15-second arrow on the nose of surrounding aircraft permits conclusions to be drawn on 
the aircraft category. 

16.1.1 Switching MT-TCAS Monitoring On / Off
→ AUX → TCAS → ON

→ ON / → OFF monitoring of TCAS data on / off
→ UNR switch Avidyne TCAD to UNRESTRICTED MODE 
→ GND switch Avidyne TCAD to GROUND MODE 

!! Only for  1. installation together with installation of the sensor !! 
→ TAS1 SEL selection of TAS source for COM1

AVIDYNE / RYAN
ZAON
FLARM / Power FLARM
GARRECHT TRX1090 / TRX 1500

(→ TAS2 SEL selection of the 2. TAS source for COM3 only for the combined signal 
Avidyne + FLARM 

FLARM )

Select the source by → UP and → DOWN, confirm with → USE, restart the MT VisionAir.
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16.1.2. Display of the surrounding traffic sent by Avidyne on the chart

On the left half of the screen TCAS AVIDYNE OK

If connected - but no data TCAS NO DATA

Air traffic within the optical range of the TCAD sensor (depends on Ryan TCAD mode) is 
displayed on the chart in relation to the terrain.

If the scale of the chart is too detailed to display all detected aircraft the symbols are 
displayed on the rim of the screen in correspondent position.

To see the position of the airtraffic on the chart choose → ZOOM → ZOOM-
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16.1.3. Display of Avidyne Data on Multi Function Display (MFD Mode)

Notes on MFD mode (= dedicated mode):

• The sighting cylinder of the Ryan TCAD sensor changes according to the set mode 

(information displayed in top line).

• In exceptional cases, signals can be received from other aircraft located outside the 

sighting cylinder determined by the set mode, but these must be treated with caution.

• Moving Terrain’s ”critical cylinder” is fixed at 1 nm.

• Since several modules (TCAS, MT Satellite radar) can be depicted in MFD mode at 

the same time, the set range is valid for all. For example, the MFD can be set at 800 
nm for assessing the current weather situation. However, as no TCAS data is 
available at long distances, there is little point in setting the MFD mode to such radii 
when only the TCAS is operating. 
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16.2. Interface to FLARM / PowerFLARM

Dynamic synchronized simulation technology DSS

As soon as other air traffic has been detected in the vicinity, a simulator is activated in 
parallel. It is calibrated to and analyzes the flight characteristics of the respective aircraft. 
This enables the pilot to determine at a glance the direction and speed (15-second arrow = 
trend vector) of approaching aircraft. 

PowerFLARM sends this airtraffic types : 

• FLARM airtraffic shown at position 

• ADS-B = Mode S + GPS position airtraffic shown at position

• Transponder Mode C undirected airtraffic, shown as range ring 

• Transponder Mode S undirected airtraffic, shown as range ring

FLARM und ADS-B Signale mit Positionsdaten werden nach folgender Logik dargestellt:  

The critical cylinder

Moving Terrain places a ”critical cylinder” around your own aircraft. 

• The radius of the critical cylinder is 1 nm. 

• Its height is 1000 feet. 
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Symbology 

A. Airtraffic with position data: 

    or         above „critical zylinder“

   or   below  „critical zylinder“

   or   within the  „critical zylinder“ → dangerous because of
flight characteristics, dangerously close

 
   or   within the  „critical zylinder“ → distance not critical

• Glider symblo

• If the speed of another aircraft is too low to represent its speed, it will appear as a 

diamond marked with F instead of an airplane. 

• Stated altitude is relative to your own aircraft (in 100 feet). 

• Red arrow pointing upwards: Climbing faster than 500 fpm

• Red arrow pointing downwards: Descending faster than 500 fpm

Speed vector:
The 15-second arrow on the nose of surrounding aircraft permits conclusions to be drawn on 
the aircraft category. 

The white text next to the aircraft symbols informs about the vertical distance between your 
aircraft and the target. The given number 22 is to be read as 2200 ft (to give an example).  

B. Airtraffic without position data 

The determined approach of aircraft with Mode S and Mode C transponders which do not 
provide information about their position, are represented as circular ring, as soon as the 
critical cylinder is achieved by the diameter of 1nm. The warning color of the ring follows the 
same logic as described above, the size of the ring shows the approach.

larger ring more distance
smaller ring closer 
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16.2.1. MT-TCAS FLARM / PowerFLARM Monitoring On / OFF

→ AUX → TCAS → ON
→ ON / → OFF Switching monitoring of airtraffic data ON / OFF

!! Only for  1. installation together with installation of the sensor !! 
→ TAS1 SEL selection of TAS source for COM1

AVIDYNE / RYAN
ZAON
FLARM / Power FLARM
GARRECHT TRX1090 / TRX 1500

FLARM

Select the source by → UP and → DOWN, confirm with → USE, restart the MT VisionAir.

16.2.2. Display of PowerFLARM Data on the chart
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On the left half of the screen TCAS FLARM 

If connected - but no data TCAS NO DATA

Air traffic within the optical range of the FLARM sensor is displayed on the chart in relation to 
the terrain.

If the scale of the chart is too detailed to display all detected aircraft the symbols are 
displayed on the rim of the screen in correspondent position.

To see the position of the airtraffic on the chart choose → ZOOM → ZOOM-

16.2.3. PowerFLARM Data in MFD Mode

Notes on MFD mode (= dedicated mode):

• In exceptional cases, signals can be received from other aircraft located outside the 

sighting cylinder determined by the set mode, but these must be treated with caution.

• Moving Terrain’s ”critical cylinder” is fixed at 1 nm.
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• Since several modules (TCAS, MT Satellite radar) can be depicted in MFD mode at 

the same time, the set range is valid for all. For example, the MFD can be set at 800 
nm for assessing the current weather situation. However, as no TCAS data is 
available at long distances, there is little point in setting the MFD mode to such radii 
when only the TCAS is operating. 

16.3. Symbology for traffic display of Avidyne + FLARM

See chapter 16.1. and 16.2 in combination. 

Surrounding traffic is shown by flashing lights (more conspicuous, esp. on chart) and color 
coding:

blue - above the critical cylinder

brown - below the critical cylinder

red - within the critical cylinder, dangerously close

white - same altitude as the critical cylinder, but outside the danger zone

• Displayed as an airplane (SQUAWK shown in white box as of Avidyne) 

• If the speed of another aircraft is too low to represent its speed, it will appear as a 

diamond instead of an airplane. 

• Stated altitude is relative to your own aircraft (in 100 feet). 

• Red arrow pointing upwards: Climbing faster than 500 fpm

• Red arrow pointing downwards: Descending faster than 500 fpm

Speed vector:
The 15-second arrow on the nose of surrounding aircraft permits conclusions to be drawn on 
the aircraft category. 

The white text display in the aircraft symbols serves to indicate the difference in altitude 
between the aircraft and the traffic. The number shown (e.g., 22) is 2200 feet.
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16.4. Symbols for data transmitted by ZAON XRX

Zaon specifies strong deviation for the transmitted bearing (±45°). To take this into account 
the surrounding aircraft are presented as circular arcs with an angle of 90°. 

The width of the circular arc is depending on the distance of the aircraft and the sclae of the 
chart. 
Zaon states the following tolerances:

Distance [nm] Tolerance [nm]

> 6,0 ± 1 - 2

3,0 - 5,9 ± 1

2,0 - 2,9 ± 0,2 - 0,5

1,0 - 1,9 ± < 0,2 

< 1,0 ± 0,1 

The color of the circular arc depends on the relative altitude and distance to the own aircraft.

Aircraft (position) color

Above the critical cylinder blue

Below the critical cylinder brown

Within the critical cylinder, not within a direct danger zone white

In the critical cylinder, DANGER due to little distance rot

Turn on the traffic display
→ AUX → TCAS → ON

Once it is started the setting will be saved and automatically turned on again at the next start 
of the system.  

The traffic display will only work if the own aircraft is moving – due to relative display. 
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17. MT-Stormscope Interface*

17.1. Switch on Stormscope display 

→ AUX → STORM → ON

See here combination of radar, TCAS and stormscope data. 
Control panel for interface monitoring in the left part of the display.

17.2. Modes

→ CELL display of cells
→ STRIKE display of strikes

→ CLR „Clear“ the screen to hide accumulated strikes or wind shear

17.3. Turn off Stormscope Mode 

→ AUX → STORM → OFF
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18. MT-Autopilot Interface: Guidance Output *

Stearing of an external autopilot via “Cross track error” signal.

Either with analog current +/- 10V
or via protocols: Aviation protocol COM3 / 9600 baud

or NMEA protocol COM3 / 4800 baud

Notes on configuration and connection of the interface can be found in the installation 
manual. 

18.1. MT-Autopilot Guidance: Modi 
→ AUX
→ AP interconnection to the autopilot

→ APRTE autopilot follows the route
→ APDCT autopilot follows the direct
→ APHDG input of heading

to correct an input type in further digits
Confirm the input with Y 
N terminates and the AP status remains as before

→ APOFF disconnect the autopilot
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18.2. AP-Guidance: Status display 

APRTE AP RTE above route information (right lower part of the screen)
APDCT AP DCT same place
APHDG AP TRK and magnetic track (3 digits) 

(same place) – it is in fact a track, not a heading!

18.3 Logic for Autopilot Guidance

Once the autopilot is in the OFF state, a neutral signal (0 V) is emitted, which leads to a 
"wing level" status. 

If the destination is reached, either at the end of the Direct vector or at the end of the last 
route segment the status is switched to AP OFF → "Wing level status."

The AP HDG status remains active, there is no terminating condition. 
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19. MT-Touch Screen *

19.1. Move the Map with Fingertips to Desired Position

The touch function allows to work with the chart in MAP mode in 2D: base charts / single 
charts / overview chart.
 
Move the map with your finger to the desired position. The map follows your fingertip. When 
you lift your finger, the movement stops. 

19.2. Selection of a Navigational Waypoint

Waypoints can be selected as well in FLT Mode as in MAP Mode in 2D (not on a single chart 
nor on the overview).

Tip on the waypoint on the map. This starts a search function in VFR IFR data base. 
• Display of a box with - ICAO identification (e.g. EDMK). 

- distance,
- elevation. 

• Only 1 active waypoint at a time, a new selection replaces the previous
• The pointer in the data base is set to this waypoint in → NavWPT.

This improves: 
- quick access to further info like frequencies, runway information and others
- Set a DIRECT → DCT
- Jump to this waypoint by → GOTO 

126 MTEX/IA-05-05



20. PDF Viewer 

Access, display and storage of PDF files.

• Access by →  AUX →  PDF
• List of all stored PDF files

NOTE:  PDFs files are NOT displayed if the

– name of the PDF file contains spaces

– name of the PDF file is encrypted

– name of the PDF file is password protected

• ERASE (delete PDF file)
• 2 modes for usage:

- OPEN (operation by the keyboard)
- OPEN-M (operation with an external USB mouse)

Operation by keyboard

• R rotate
• Q quit the PDF viewer
• P go to previous page 
• N go to next page
• D move down 
• U move up 
• 1-9 quick page forward in the (big) PDF file, page 10/20/30/40... /90
• function keys  zoom in 400% to 12,5%
• I J L M Scrolling down, up, left and right (logic analogue to scrolling of base charts)

21. NVG Mode (Night Vision Goggles) 

Dimming with the * button on the left side. 
Further dimming leads to NVG Mode. Last settings get saved. 
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22. MT-Mission Management System *

22.1. Components for the Mission Management System

22.1.1. Hardware
• MT-VisionAir X with SW version min. X.5.1 (OS13)

• Iridium Transceiver Antenna System (ITAS), Serial interface: 19200 bps

• Test cabling with power/serial M12/8pin connector

• MDR50 central connector with power, Fast Integral GPS and COM3 (pin assignmen 

see Installation Manual)

ITAS must be connected to serial COM port 3.

22.1.2. Contract for SBD (Short Burst Data)
Sign a contract for Iridium SBD. The IMEI no.  of the ITAS module is part of the contract. (Mo 
ACK is not necessary). 

22.1.3. Contract with Rescue Track
Rescue Track needs to know the IP adresse for the hosting service.

22.2. Software

22.2.1. Basic information
This module is an option and needs to be activated by MT.

22.2.2. Settings on the Moving Terrain System

22.2.2.1. Choice of ITAS Module for Communication
→  AUX → SETUP -> DIAL-UP 
Select IRIDIUM TRANSCEIVER ANTENNA SYSTEM (ITAS) by pressing UP / DOWN and 
confirm with USE.

The setting is saved.
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22.2.2.2. Activation of data transfer to and from Rescue Track

The tracking system is always on and the position data is transmitted every 120 seconds to 
the server in Rescue Track.
The initialization of communication with Rescue Track has been made at the factory.

An interruption / disconnection can be done by turning off the ITAS module.

22.3. MMS via Rescue Track on the Bildschirm 
→ AUX → MMS

   (in the background: normal map screen)

         

GOTO DCT msgUP msgDN BACK
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Received messages (latest on top)

2015-02-21 14:57 from: Sender
   

Text of received message 5   N42°12.1 E013°20.5

2015-02-21 14:50  from: Sender
Text of received message 4

2015-02-21 14:40  from: Sender
Text of received message 3

2015-02-21 13:25  from: Sender
Text of received message 2

2015-02-21 13:20  from: Sender
Text of received message 1

RescueTrack status

Frei auf Funk >

Frei auf Wache >

Einsatz übernommen >

Am Einsatzort >

Sprechwunsch >

Außer Dienst >

Patient übernommen >

Im Krankenhaus >

Ferry Flight  >



22.3.1. Description of the Screen

Left half: incoming messages, the latest can be found at the top
Right half: standardized messages that are sent from the helicopter. 

22.3.2. Incoming Messages

In the left half of the screen the last 5 incoming messages are displayed, the most recent at 
the top.
The latest message is automatically marked as active (highlighted green).

It is possible to choose one of the other messages
→ msgUP up or
→ msgDN down.

The selected message will be highlighted.

Once coordinates are included in the message, you get the choice of these options:
→ GOTO → the map is centered according the given coordinates

(ATTENTION: This ends the MMS menu!)
→ DCT → to set a directs to the given coordinates

The destination appears as RTDEST. 

22.3.3. Recalling a message to the control center on the Moving Map

As soon as a new message arrives a hint is displayed in the 
main menu:

The hint    f l a s h e s   for better visibility.

Once the pilot has seen the message → AUX → MMS, this 
notice expires .
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22.3.4. Selection of the Standardized Status Messages Using the Keys 2- 0
– Press of the button → the message turns to cyan

– The sending is done automatically with the next position report

– Then the message remains green  until another message is selected

Color coding of the current status:

– highlighted cyan = selected but not yet transmitted

– highlighted green = selected and transmitted

22.3.5. BACK
– Back to Main Menu - Moving Map.
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23. MT-Video Input Device (MT Camera) *

23.1. Technical Description

A separate MT Video Input Device is part of the system. 
Connection via USB, recommended to use the central connector. 

Power supply of the MT Video Input Device via MT-VisionAir X (USB connection)

Possible signals: Composite video (CVBS, RS 170)
PAL
NTSC

Input: 1 x CVBS (composite video input, 75 Ohm) via BNC
Cinch connection via BNC-RCA adapter possible

Display: full screen in 4: 3 format with maximum resolution 1024 x 768 pixels.

23.2. Operation MT Video Input

Operation via hotkey C (C key on the keyboard).

C switches to Video In
C switches back to MFD screen with moving map functions 

24. MT-VGA Output Device *

A separate MT VGA Output device is part of the system. 
Connection via USB, recommended to use the central connector. 

Power supply of the MT Video Input Device via MT-VisionAir X (USB connection)

Output in VGA format.
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25. Software Updates, OS Upgrade, Backup of User Data

25.1. Information about the system

→ AUX → SETUP→ VERSION
the current version number is displayed

1 x press: SW version

2 x press: version of software
OS (operating system) version
Details for data storage
Hardware ID + in brackets type of CPU
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25.2. Software Update / Update of Charts and Data

25.2.1. Prerequisites

For the updates you need:

• Power supply

• USB stick = update stick

The USB stick contains the file firmware.img. 
Either the data have been downloaded from our website and saved on the stick or we send 
the prepared USB stick..  

25.2.2. Procedure

Make sure a uninterrupted power supply is provided.

• Power off MT-VisionAir 

• Insert USB stick into the slot on the left bottom side of the MT unit with the logo 

showing upwards. 

• Switch on MT-VisionAir X

• Update starts automatically

• Update was successful when the following message is shown: “Installation complete. 

Please remove update device and restart.”

• Switch off MT-VisionAir X

• Remove the USB stick carefully and parallel to the slot. 

• Switch on the unit again: starting the program might take some time. Once the keys 

are shining blue, background processes are running and MT program will be started 
soon. 

For a long update process, the screen may turn dark (enter the sleeping mode). To get the 
message of the successful update, please press the * button on the bottom left, so that the 
panel again „wakes up“. Wait for the message, do not pull out the stick before. 
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25.3. Upgrade of the Operating System

25.3.1. Prerequisites 

You will need:  

• Power supply

• USB Stick, which is prepared as upgrade stick, marked as OS Upgrade

• USB keyboard: please use a commercial keyboard and conntect to one of the 2 USB 

slots on the back of the unit.

25.3.2. Info CPU Type

There are different types of CPU in the devices in use - and they have to be prompted with 
different commands to boot from the USB stick.
Inform about the built-in MT-X VisionAir Processor Type: 

→ AUX → SETUP → VERSION Displays the current version 
press 1 x: SW version
press 2 x: version of the operating system (OS) 
processor type TT or SP 

25.3.3. Procedure

• Plug in USB keyboard

• Make sure a uninterrupted power supply is provided

• Plug in USB stick “OS Upgrade” into the slot on the left bottom side of the MT unit

• Start the unit 

• As soon as the BIOS boot logo appears (space picture), 

• press and hold F11 for SP board 

• press and hold F7 for TT board till a selection menu for boot device is 

shown.

• Select the USB stick in the boot device menu (mostly the 3rd option) (cursor down), 

and confirm with ENTER.

• Unit will boot from USB stick. Follow the onscreen instructions

• Restart the unit without USB stick and keyboard.
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25.4. Backup of User Data

25.4.1. Prerequisites

For the backup you need:

• Power supply

• USB stick (FAT32 formatted)

25.4.2. Procedure

Make sure a uninterrupted power supply is provided.
Insert USB stick into an USB slot – you can also choose the remote USB Slot via central 
connector.

• Press → AUX → SYS → BACKUP

• This triggers a current backup of:

- USER waypoints / routes / tracks
- Logbook
- Blitzplan FPL list and log in data
- saved PDFs
- current settings for display and system

• Wait till status changes to: 

• Press → BACK

• Remove the USB stick

The data backup is now completed and can be transferred to 
other MT-VisionAir X
Backup workstation
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25.4.3. Error Message

If the USB stick cannot be detected the following error massage shows up: 

25.5 Restore of User Data

→ RESTORE restores the data from the backup USB stick,
e.g. to synchronize several MT-VisionAir X systems

25.5.1. Procedure

Attention All user data on the unit will be overwritten!

Make sure a uninterrupted power supply is provided.

• Insert USB stick (FAT32 formatted) with user data you want to restore into the USB 

slot.

• Press → AUX → SYS → RESTORE

• Data which are restored (= overwritten):

 - USER waypoints / routes / tracks
- Logbook
- Blitzplan FPL list and log in data
- saved PDFs
- current settings for display and system
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26. MT-OPS Database Editor *

26.1. Purpose

MTOPSDB is a simple tool to:
a) Maintain the “OPS” waypoint database on a PC
b) Load the "OPS" waypoints into MT VisionAir X units.

An “OPS” database contains waypoints that cannot be edited by the pilot but can only used 
as they are - as opposed to “USER” waypoints.

The “OPS” waypoints can be accessed on the VisionAir X through:  navWPT - DBASE - OPS 
(see the manual for details)

26.2. Prerequisites

- Windows OS  (tested on Windows XP SP3, Windows 7 64-bit)
- USB port
- USB memory stick to transfer the data to the VisionAir X

26.3. Installation

- Extract the provided archive to a folder of choice ( e.g. c:\utility\mtopsdb ) maintaining the 
directory structure.
The program can be easily moved (even to another computer) as the software does not store 
any information outside its own folder.

- Optionally create a shortcut on the Windows start menu.
A quick way to do this: right-click on “mtopsdb.exe” an select “pin to start menu.

26.4. Usage

Start the program “mtopsdb.exe”

A window will appear:
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26.4.1. Editing waypoint data

Click EDIT to open an editor (similar to Excel) where the waypoints can be managed:

Change, add or remove records as needed (see paragraph 5 for details)
When done, save the changes (File - Save) and leave the editor (File - Exit)

The initial window (EDIT - EXPORT - Exit) will appear again.

26.4.2. Exporting waypoints to the VisionAir X

• Plug an USB memory stick into the PC

• Preferably the USB stick should be empty or contain only a previous export of the 

OPS database, to avoid mixing extraneous files.

• If not already running, start “mtopsdb.exe”

• Click EXPORT, the software will show the following window:
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- Click on the destination drive letter and press OK
NOTE: do not select a specific folder, just the drive letter.

When the operation is complete the software will remind how to load the OPS waypoints into 
the VisionAir X:

- Click “Ok” to return to the main selection screen (EDIT - EXPORT – Exit)

26.4.3. Loading the OPS database into the VisionAir X

• Power up the VisionAir X

• Plug the USB memory stick (where the waypoint data has been exported) into any 

USB port of the unit

• Press: → AUX → SYS → RESTORE

The unit will list the data that can be read from the USB stick:
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IMPORTANT: ensure that the displayed list contains ONLY the OPS waypoint database.

If other data is listed (e.g. User Waypoints from a previous backup) do not proceed unless 
you really want to reload all the listed databases and completely replace them on the unit. If 
unsure, erase everything from the USB stick and repeat the EXPORT operation.

To confirm loading the data on the unit press RESTORE again, otherwise press BACK.

Once the data has been loaded the VisionAir X will display a confirmation and will restart 
itself to update the database index:

The OPS database page should now display the loaded information, press navWPT - 
DBASE - OPS to verify:
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26.5. Details on editing the OPS waypoints

The MTOPSDB utility maintains the waypoint database in an Excel file (XLS format) named 
“mtopsdb.xls”
As such it can also be edited directly with Excel itself or a similar program (e.g. OpenOffice 
calc).

NOTE: Do not use the newer format “XLSX” introduced with Excel 2007, always save in 
"XLS" format.

The instructions below will describe the included editor but are mostly applicable to Excel, 
too.

26.5.1. Data format

The first row of the file must contain the column headers:

Name ID   LatHem LatDeg LatMin LatMMin LonHem LonDeg LonMin LonMMin Comment WptType
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All other rows shall contain the waypoints - one per row - entered in the following format:

Column Field Example Description

A Name ARBEDO Long name of the waypoint (maximum 30 characters)

B ID ARBED Short identification of the waypoint (maximum 7 characters)

C LatHem N Latitude sign: N or S

D LatDeg 46 Latitude degrees (00 .. 90)

E LatMin 12 Latitude minutes (00 .. 60)

F LatMMin 880 Latitude 1000ths of minute (000 .. 999)

G LonHem E Longitude sign: E or W

H LonDeg 009 Longitude degrees (000 .. 180)

I LonMin 02 Longitude minutes (00 .. 59)

J LonMMi

n

530 Longitude 1000ths of minute (000 .. 999)

K Comment LSZL VRP Arbedo Optional remark (maximum 250 characters - must be a single line)

L WptType 0 Optional - if present must be always 0 (zero) - reserved for future 
expansion

Notes about format:

• Changes of graphical formatting (font, color, column width) are safe and ignored by 

the conversion utility

• Empty rows are ignored

• Do not insert more than one line of text in a field (e.g. Comment)

• Spaces inserted in ID / NAME / Comment are handled properly

• The order of the rows is not relevant as the VisionAir X will reindex all waypoints by 

ID and name. However for easier maintenance on the PC they can be sorted - see 
below (5.3)

25.6.2. Deleting waypoints
Right-click on the row number to delete (on the left) and select “Delete”:

Multiple waypoints can be deleted:

• Select several rows (click on the first row number and drag the 

mouse down)

• Right-click and select “Delete”

 

25.6.3. Inserting waypoints

Usually new waypoints should be added at the end of the list, but it is also possible to insert 
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a new row in the middle.

• Right-click on the row number that should be moved down to make room

• Select “Insert”

25.6.4. Sorting waypoints

This is not a necessary operation, the VisionAir X always displays waypoints sorted by ID 
and Name automatically
However it can be easier to work on a sorted list on the PC.

To sort the records alphabetically:

• Click on the gray area on the upper left corner (on the left of 

“A” column and before row “1”) to select all the rows:

• From the menu bar select: Format - Data - Sort

• A dialog box will appear, select the sorting column(s) - usually “Name” or “ID” - and 

press “OK”:

25.6.5. Searching for waypoints

• Press CTRL + F (or select Edit - Find) to search for a specific text in the whole file.
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27. Autopilot Servo + Attitude + GPS Output *

27.1. Purpose

This function provides an high-speed serial data stream containing:

• -Aircraft attitude

• GPS position

• Autopilot steering

27.2. Prerequisites

The Attitude+GPS Output will only work when:

• The unit is calibrated

• MT-EFIS* is enabled 

• The Autopilot Servo + Attitude + GPS Output function is enabled in mtpro.ini

27.3. Configuration

To enable the Attitude+GPS Output add the following to “mtpro.ini”:

[AttGpsOut]
Port = 3

In the example the output is sent to COM3.
If “Port” is set to 0 (zero) the data output remains disabled.

27.4. Operation

The Attitude+GPS output is always active (data is always sent) when configured in mtpro.ini 
(unless “Port” is set to zero).

27.5. Protocol Specification

27.5.1. Serial line configuration:
• Speed 115200

• Data bits 8
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• Parity N

• Stop bits 1

Flight Data packets are transmitted continuously at an average rate of 50 - 65 per second 
(depending on system load)

27.5.2 Packet format

Field name C type Length
(bytes)

Description

sync1 unsigned int 4 Synchronization bytes
Always 0xFFFFFFFF

sync2 unsigned int 4 Synchronization bytes
Always 0xFFFFFFFF

pkt_type unsigned 
char

1 Always 1 (new packet types may be added in 
future)

pkt_len unsigned 
char

1 Number of remaining bytes in packet
Always 50 (packet length - 10) for packet type 1

ts_msec unsigned 
short int

2 Timestamp - milliseconds part of ts_sec

ts_sec unsigned int 4 Unix Timestamp (seconds since 01/01/1970) 

GPSLat double 8 GPS latitude (degrees)

GPSLon double 8 GPS longitude (degrees)

GPSAlt float 4 GPS altitude (feet AMSL)

GPSTrack float 4 GPS true track (degrees)

MagVar float 4 Magnetic variation at GPSLat, GPSLon
(from world magnetic model)

AHRSPitch float 4 Pitch attitude (degrees, nose up is positive)

AHRSBank float 4 Bank attitude (degrees, bank right is positive)

AHRSTrack float 4 Gyro-assisted GPS true track
(Responds instantaneously to aircraft yaw 
movements)

Flags unsigned int 4 Flag bits (value --> meaning):
1 --> GPS fix is valid (otherwise ignore 
GPS fields)
2 --> AHRS pitch/bank are valid
4 --> AHRS track is valid
8 --> AP Steering is valid
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16 --> AP Selected Altitude is valid

APSteering float 4 Autopilot lateral steering
Range: -100 .. +100  (positive = Aaircraft turn to the 
right)

The value 100 represent full turn rate and may be 
interpreted as a standard rate turn (3 deg/s)

APElevator float 4 Elevator Servo Position (Range: -100 .. +100  
(positive = Aircraft moves nose-up)

Total packet size: 68 bytes

Note 1: Data types are in “x86” format (32-bit platform, “little-endian”)

Note 2: GPS fields are only updated when new position data arrives (4 Hz for Fast Integral GPS).

Note 3: The AHRS “yaw” is slaved to the GPS true track (this explains the name “AHRSTrack”)
Magnetometer data is not available in current software release, and for the time being the
VisionAir X does not know the aircraft heading but only GPS track.

Note 4: Timestamp is synchronized to GPS UTC time

Note 5: Peak transfer rate is: 68 (packet size) * 65 (peak packets/sec) = 4420 bytes / sec
(about 40% of bandwidth)

27.5.3. Declaration of packet structure (C language)

#pragma pack(push)
#pragma pack(1)
typedef struct
{

unsigned int sync1; // Synchronization bytes: 0xFFFFFFFF
unsigned int sync2; // Synchronization bytes: 0xFFFFFFFF
unsigned char pkt_type; // Packet type, 1 for MT_FLIGHTDATA (for 

protocol expansion)
unsigned char pkt_len; // Remaining bytes in packet 

[sizeof(MT_FLIGHTDATA) - 10]
unsigned short int ts_msec; // Milliseconds part of timestamp
unsigned int ts_sec; // UNIX timestamp - seconds
double GPSLat; // Degrees
double GPSLon; // Degrees
float GPSAlt; // AMSL altitude in feet
float GPSTrack; // GPS true track (deg)
float MagVar; // Magnetic variation (WMM) at GPSLat, 

GPSLon
float AHRSPitch; // Pitch (deg, nose up = positive)
float AHRSBank; // Bank (deg, bank right = positive)
float AHRSTrack; // Gyro-assisted GPS true track (deg)
unsigned int Flags; // See below: MTFD_xxx constants
float APSteering; // Autopilot roll steering
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float APAltSel; // AP selected altitude (feet)
} MT_FLIGHTDATA;
#pragma pack(pop)

// Values for Flags bits
// Values for Flags bits
#define MTFD_GPSFIX (1 << 0) // GPS fix is valid (thus GpsXXX fields are 
valid)
#define MTFD_AHRSATT (1 << 1) // AHRS attitude is valid
#define MTFD_AHRSTRK (1 << 2) // AHRS track is valid
#define MTFD_APSTEERING (1 << 3) // Autopilot steering is valid
#define MTFD_APALTSEL (1 << 4) // Autopilot selected altitude is valid

MTEX/IA-05-05 149



 

28. Mission Management Program MT Operations 
Center 1.0

28.1. Requirements

• OS: Windows XP (32 bit) or Windows 7 (32/64 bit)

Note: other Windows versions may work but have not been tested

• RAM: minimum 1 GB (recommended at least 2 GB)

• Disk space: Software installation needs at least 60 MB (MT OPS Center) + 180 MB 

(Google Earth)

• Dedicated e-mail account for receiving Iridium SBD messages.

• Supported mail protocols: POP3, IMAP (both unencrypted and SSL)

• The mailbox must be linked to the Iridium SBD contract and should not contain 

any messages (other than the ones arriving from Iridium).

• It is recommended to clean the dedicated mailbox from any "welcome" or 

similar messages that may have been generated when the account was 
created. 

• This release of the software does not send e-mail messages, thus an "SMTP" 

server is not required at this time (but may be in future versions)

• Time: it is recommended to maintain the computer's clock correctly synchronized 

(e.g. with an Internet time source). It is not necessary to set a specific timezone, but 
all times shown in MT OPS Center will be referred to UTC.

28.2. Diagram of functionality
Displaying target

positions on Google Earth

  MT    →  Iridium → SBD binary data → MT OPS Center Software  →  *. kml readable data  

Displaying target
 positions on customer's GIS

28.3. General note for installation

It is recommended to install and run MT Operations Center 1.0 within an user account with 
"administrator" privileges on the machine.
This release works with Google Earth to display the position of the targets; the latest version is provided 
as a convenience, but it is exactly the same that can be downloaded for free (at the time of writing) from: 
http://earth.google.com.
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28.4 Install MT OPS Center

• Start the installer named "MTOpsCenter-setup.exe"

• It is suggested to leave all the installation options active, including "Runtime library 

(Visual C++ 2008)", unless it is known for sure that this component is already present 
on the machine.   (Press "Next >")

• The installation folder defaults to "C:\MTOPSCenter" (not the standard "Program 

Files") as the software does not support folder names containing spaces; moreover 
Windows 7 / Windows Vista security may prevent the program from running correctly 
if it is hosted under the "Program Files" system folder. (Press "Install")

• Once the file copy has completed press "Close" (the button will be disabled until the 

process has finished)

The installer adds a new program group named "MT OPS Center" in the Windows Start 
Menu.

28.4.1 Configuration

Before starting the software the first time it is recommended to configure it as follows:

Start --> Programs --> MT OPS Center --> Edit configuration

This will open the Windows Notepad to edit the configuration file ("mtopscenter.ini")
Lines starting with ';' are comments; empty lines are ignored by the program.
There must be no spaces between the elements of each configuration line, and no spaces at 
the beginning or ending.

Parameter Description

mailprotocol= Protocol to use with the mail server, either pop3 or imap
Must be given by the mailbox provider

Example: mailprotocol=pop3

mailserver= Name of the mail server
Must be given by the mailbox provider

Example: mailserver=pop3.example.com

mailport= Service port of the mail server
Must be given by the mailbox provider

Example: mailport=110

mailoptions= Additional options used to connect with the mail server
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If the mailbox uses SSL (encryption) it is recommended to 
enter the following:

mailoptions=/ssl/novalidate-cert

Otherwise leave blank

mailuid= Username used to access the mailbox
Must be given by the mailbox provider

Example: mailuid=sbd

mailpwd= Password used to access the mailbox
Must be given by the mailbox provider

Example: mailpwd=secretpassword

mailcheckintv= Interval between mailchecks (in seconds)
If the default 15 seconds generates too much load on the 
mailserver it can be changed to 60 seconds or more.

Example: mailcheckintv=15

activetimeout= Timeout (minutes) to consider a target inactive
If an "active" target does not send any information within the 
specified time from the last message it becomes "inactive"

Example: activetimeout=4

Save the file and close the text editor when done.

The next step is to set up the callsigns / tail numbers of the targets that will be tracked.

Start --> Programs --> MT OPS Center --> Edit fleet

The fleet configuration file will open in Windows Notepad (filename: "fleetdata.ini")
This file should contain a  description for each Iridium Satellite Phone that is tracked by the 
system.

The format is:

imei_code=tail_number

Example:

300115010909999=D-HXXX
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Where "imei_code" is the IMEI identifier of the Satphone, and "tail_number" is the aircraft 
identification that will appear in the OPS Center.
Lines starting with ';' are comments, and empty lines are ignored.
There must be no spaces between the elements of each configuration line, and no spaces at 
the beginning or ending.

Save the file and close the text editor when done.

28.4.2 Usage

Launch the program from the Windows Start Menu:   Start --> Programs --> MT OPS 
Center --> MT OPS Center

NOTE: It is not possible to use two copies of MT OPS Center at the same time on the 
same mailbox. The program will delete the Iridium messages as it processes them, so that if 
more than one copy is pulling the messages from the same account the tracking will be 
erratic. However it possible to run two copies on two different mailboxes if the Iridium SBD 
contract is set up to deliver messages to both of them simultaneously.

28.4.3 Main program window

All areas are initially blank and the program status is initially "IDLE": the user has to perform 
an action before anything will happen.

Press the "Start" button to begin processing of the tracking messages (program status 
shows "RUNNING")
The program will then check the mailbox periodically and update the "target list" as new data 
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becomes available.

The button "Open map" will start Google Earth and make it show the current position of the 
targets.
When Google Earth is started in this way it will continue to update the target positions 
according to the data that is processed by MT OPS Center.

The "Stop" button suspends the processing of the tracking messages: no position updates 
will be received and any Iridium messages from the satellite phones will remain queued in 
the mail server until the tracking is resumed.
Program status indicator shows "STOPPED".

The "Clear" button deletes all target data and removes all text from the message window. 
The targets will reappear only when they send the next position report.

The "Quit" button will close MT OPS Center. If Google Earth is still open it will not display 
updated information anymore, but will be up-to-date again if the OPS Center is launched and 
tracking is resumed.

Explanation of the columns shown in the target list

ID Target identification 
The data packets coming from the Iridium devices are identified by the unique 
IMEI code of each satphone.
If MT OPS Center knows about the sender (as configured in "fleetdata.ini") it will 
show the corresponding aicraft registration, otherwise it will display the full IMEI 
code of the transmitting equipment.

Status Target active / inactive indicator
If the target sent any message recently it will show "Active", otherwise "---" 
(dashes)
The target activity timeout can be configured and defaults to 4 minutes

Lat/Lon Last reported target position
The format is in degrees and minutes with decimal part: Ndd mm.mmm Eddd 
mm.mmm

Alt Last reported target altitude (feet AMSL)

TrueTrk Last reported true track (degrees)

Speed Last reported ground speed (kts)

LastRep
ort

UTC time of last position report
NOTE: This timestamp is provided by the Iridium network and represents the 
instant when the data packet was accepted by the satellite. It is typically 6 - 9 
seconds later than the actual UTC time when the GPS position was acquired.

If the message window shows any error related to the mail server connection, the 
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configuration should be reviewed to ensure all the parameters are correct.
It is recommended to "Quit" and restart the program after modifying the configuration file.

MT OPS Center will process all queued Iridium messages, so that it may take a few 
moments for it to catch up if the targets have been already sending tracking information for a 
long time.
Note that old queued messages will not show the corresponding target as "Active" unless 
they are recent enough.

28.5 Displaying target positions on Google Earth

28.5.1 Install Google Earth
Start the installer named "GoogleEarthWin-7.12.2041.exe" and follow the on-screen 
instructions.

Note that if a previous version of Google Earth is already installed on the machine this step is 
not strictly necessary: MT OPS Center should work with Google Earth versions as old as 
5.x / 6.x

28.5.2 Settings in Google Earth
We recommend to take a few minutes now to start Google Earth the first time and change 
few settings which will make it more suitable to use with MT OPS Center:

• A window named "Start-up Tip" may open automatically. At its bottom deselect "Show 

tips at start-up" and click "Close".

• On the bottom of the Google Earth display there could be a "Tour Guide" strip 

containing photos. We suggest to disable it:

• Open the "View" menu on the top of the Google Earth window

• Deselect "Tour Guide"

• To increase performance we suggest to disable all the layers that are not of 

operational interest (e.g. Ocean, Weather, Places). These can be 
activated/deactivated on the bottom left section of the Google Earth window. It 
may be useful to leave "Borders and Labels" activated.

• It is suggested to delete the "Sightseeing Tour" layer that is listed on the left of 

the Google Earth window (under "Places"). To do so:

• Right-click on "Sightseeing Tour"

• Choose option "Delete"
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• Confirm the deletion when asked

• Open the "Tools" menu and click on "Options"

• In the "3D View" tab:

• Set the preferred Latitude/Longitude format

• Set the preferred units of measurement

• In the "Navigation" tab:

• Select "Do not automatically tilt while zooming"

• Click "OK" to save the settings

Now Google Earth should be closed (File --> Exit) to proceed with the installation.

Google Earth is launched by pressing "Open Map". Once the program starts the left area of 
the window should show the data that is being fed by MT OPS Center, under the "Temporary 
places" folder.
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- The map can be "dragged" with the mouse to scroll the view (the arrow keys will also move 
the map)
- Rotating the mouse wheel will zoom in/out (also the keys "page up" and "page down" will 
work)
- By holding the mouse wheel pressed and moving the mouse, the view will tilt/rotate and 
show the 3rd dimension: targets are connected to the ground by a thin white line to highlight 
their height over the terrain.
- Pressing the "R" key should revert to a top-down view.

NOTE 1: In average it will take between 6 and 20 seconds for the Google Earth targets to 
be updated after the onboard equipment sends its position report. The onboard software 
attempts to report the aircraft position every 60 seconds.

NOTE 2: When closing Google Earth the program will ask whether the items under 
"Temporary places" should be saved into "My Places". It is recommended to press the button 
"DISCARD", otherwise on the next program run the target data will appear doubled. If this 
happens it is recommended to remove the item "MTMMS Targets" shown under "My Places" 
by right-clicking on it and choosing "Delete".

28.6 How to extract data for "displaying target positions on 
customer's GIS"

The latest target data can be read out of a file named "targets.kml", contained in the "MT 
OPS Center" installation directory.
This file is rewritten every second.

Description of "targets.kml" 

The file contains a  <Placemark> KML element for each target that is being tracked by MT 
OPS Center.

Each <Placemark> is made up of these sub-elements:

- <name> contains the aircraft ID
- <description> contains the text that would be shown in Google Earth when the target is 
selected with the mouse
- <styleUrl> references the placemark symbol (icon) that is defined in the KML header and is 
always "#mtmms_tgt"
- <Point> contains other sub-elements specifying the target position:

<extrude>1</extrude> instructs Google Earth to draw a vertical line joinint the target 
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with the ground
<altitudeMode>absolute</altitudeMode> indicates that the altitude is AMSL (0 = sea 

level)
<coordinates> contains the actual 3D coordinates of the target, separated by 

comma:
- Longitude (degrees)
- Latitude (degrees)
- Altitude (meters)

--- Sample dump of "targets.kml" 
-------------------------------------------------------
<?xml version='1.0' encoding='ISO-8859-1'?> 
<kml xmlns='http://earth.google.com/kml/2.0'>' 
<Document> 
<Style id='mtmms_tgt'> 
 <IconStyle> 
  <color>ff00ffff</color> 
   <Icon id='fdp_tgt_icon'> 
    <href>http://maps.google.com/mapfiles/kml/shapes/open-
diamond.png</href> 
   </Icon> 
  </IconStyle> 
  <LabelStyle> 
   <color>ff80ffff</color> 
  </LabelStyle> 
  <ListStyle> 
  </ListStyle> 
</Style>

<Placemark> 
 <name>MT9555</name> 
 <description>Alt: 2539ft TTRK: 046 GS: 0kts<br/>Pos: N47 41.032' E010 
20.933'<br/>Last report: 2014-03-06 17:05:08</description> 
 <styleUrl>#mtmms_tgt</styleUrl> 
 <Point>
  <extrude>1</extrude>
  <altitudeMode>absolute</altitudeMode>
  
<coordinates>10.348888397217,47.683860778809,773.88719882369</coordinates>
 </Point> 
</Placemark> 

</Document> 
</kml>
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